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Chapter 1. Getting Started With V4.0 

About these notes 
These update notes are provided for existing users as a supplement to the 
existing Pulsonix Users Guide. These notes are to highlight new features in 
version 4.0 and to briefly describe their use. 

Each chapter is broken down into logical functional descriptions based on the 
application type, Schematic design, PCB design etc. 

Installing the New Version of Pulsonix 
It is recommended that you back-up all libraries, designs, technology files, 
profile files, reports and netlists before installing the latest version. Other than 
for any reason, this is good working practice, although you should have a backup 
already of all of this data!  

As with any other installation of Pulsonix, insert the CD and wait for a short 
time. The Autorun facility will start the installation procedure. Follow the on-
screen messages from the install wizard. You can install Pulsonix version 4.0 on 
top of your existing installation, you do not need to uninstall any old version 
first. 

New License 

Version 4.0 requires a new license that will be supplied to you with the update or 
by email.  

For existing users it is recommended that you simply click the No Change In 
Licensing check box on the licensing page of the Installation wizard. New 
licenses and changes to network licensing can be made after the installation 
using the License Manager. 

New System Files 

There are no new system files for version 4.0. However, if upgrading from an 
older version than version 3.0 then there is a change to the system files that are 
installed. If you have this older version, then during installation, from the 
Change Components page of the installer, then the System box should be 
checked. 



10   Getting Started With Version 4.0 

New Menu Options 

Although detailed later on under Customise Dialog Changes, you should note 
that the standard menus and toolbars have been changed. If you wish to modify 
yours to match the new standard then you can use the Reset options from within 
the Customise dialog (on the Settings menu) for Toolbars and Menus. 

Installation Notes for existing Pulsonix Spice Users 

File locations 

The simulator files are now in the \Pulsonix-Spice folder beneath the main 
Pulsonix folder. Pulsonix Spice version 1.0 files remain in the \Spice sub-folder, 
as it may contain some of your own model files. 

The following files now live in the \Application Data folder on your computer, in 
a \Pulsonix\Pulsonix-Spice sub-folder. 

 out.cat 

 user.cat 

 map_symbols.txt 

 oem_symbols.txt 

If you don't know how to get to the application data folder on your computer use 
the utility program FindAppDataDir.exe to show the folder path. This is located 
in the ...\Pulsonix-Spice\Support\Help folder. 

Installing your own models 

After installation, the simulator will contain the newly installed set of model 
libraries. You will need to re-install your own model files into the Simulator. 
You can install your model files or a folder containing them by picking them up 
in windows explorer and dropping them into the Pulsonix Spice command shell. 

If you have made changes to the categories or Parts used by the models using the 
Associate Models & Parts option, you’ll also need to copy the user.cat file to 
the new installation folder. To do this, copy user.cat from the 3.1 ...\Spice\Script 
folder to the Pulsonix Spice application data folder (described above). 

Pulsonix Parts 

If you had changed the part names for the simulator's built-in models (e.g. NPN) 
using the Pulsonix 3.1 Simulator Setup dialog. You will either have to do this 
again with version 4.0,or copy the map_symbols.txt file from the 3.1 
...\Spice\Script folder to the Pulsonix Spice application data folder (described 
above). 
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Use the Pulsonix Library Manager to make sure the Pulsonix 4.0 program is 
pointing to your own parts libraries. This should already be set up as Pulsonix 
library paths are retained from 3.1. 

If you have changed the standard spice parts (Spice.lib) or have new parts that 
contain spice information, you will need to run up the Pulsonix Simulator> 
Simulator Setup dialog from the Simulation menu and use the Update 
Simulator Parts List button to recreate the oem_symbols.txt file to inform the 
simulator about your parts. 

Simulator Scripts 

If you have your own scripts, either copy them to the ...\Pulsonix-Spice\Script 
folder, or change the simulator to point to your scripts folder using the File 
Locations page of the Simulator's File menu and Options, General dialog. 
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Chapter 2. General Options 

Updated GUI 

Application Look 

The appearance of the Pulsonix user interface can be tailored using a new option 
named Application Look, this is located on the Customise option. 

 
By default the .NET 2005 look will be adopted at installation with the workbook 
tabs at the bottom of the design area. 

Changing the Application Look will affect the appearance of items such as 
windows, toolbars and menus. Use the Apply Changes button to apply the 
changes to the design. 

XP Look 

If the Windows Classic theme is selected on the XP platform, Pulsonix will 
revert to its previous style interface. On all non-XP platforms, the interface will 
remain unchanged. 

XP Themes and Appearance 

When running under Windows XP, Pulsonix will now make use of the new XP 
visual contents such as Themes and Appearance settings, which are available on 
the Desktop via the Display Options in the Control Panel. Using the Windows 
XP theme will adopt the current theme colour and display controls, such as 
buttons, combo-boxes, and lists will appear with the new XP look and feel. 
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Auto-hide Dockable Windows 

All dockable windows, such as World View, Layers etc. may now be switched to 
be an Auto-hide window. This means they can still be docked but now you can 
also make them docked but visible as a button to the side of the Pulsonix 
framework (see below – this example of the three windows are docked on the 
right side of the design area). When you hover the mouse over one of these 
buttons, the appropriate window ‘slides’ into view ready to use. 

 
There are three small icons along the top of this window, (moving left to right) 
these indicate a drop down shortcut menu (also available as a shortcut menu in 
the window by right clicking the mouse), a pin to enable the dialog to be sliding 
to conceal it or docked to be permanently displayed, and a Close button to 
dismiss the dialog altogether. 

 

Tabbed Windows 

The window can also contain tabs within any other dockable window options. 
You can switch between any of these windows by clicking on the appropriate 
tab. 
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A tabbed window contains multiple dockable windows and may be manipulated 
like any other dockable window in that it may be resized, docked, floated or 
auto-hidden. Additional dockable windows may be dragged into the tabbed 
window and existing tabs may be dragged out to become individual windows 
once again.  Tabs may be re-ordered simply by dragging them into the desired 
order.  

Depending on the application ‘look’, Pulsonix will now also provide you with 
some extra features to aid the docking of tabbed windows (these are not available 
in the XP Look). 

Docking Indicators 

When running the latest application look, docking indicators appear to show the 
potential dock positions which can then chosen by releasing the drag with the 
mouse pointer over the appropriate indicator. The docking indicator is different 
when over an existing docked window. 

 
To reposition a docked window, press and hold down the left-hand mouse button 
on the window title bar border and drag the window frame to the desired docking 
indicator. Any of the four ‘outside’ indicators will allow the window to be 
docked. By dragging it over the centre indicator, it will be added to the existing 
window as a new tab. 
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When used on a dockable window it looks like this: 

 
Outside the main docking indicator are four other position indicators. These 
show that the window can be docked to the adjacent edge of the design area of 
main Pulsonix framework. 

New tab dialog style 

Dialogs that use tabs to select pages have been replaced with the new style 
dialog showing the individual pages along the left hand side of the dialog. (Note: 
not all tabbed dialogs have been changed). 

 
The tabs are categorised (such as Styles, Rules etc.) and sub-categorised into 
functional areas (such as Pad Styles, Track Styles etc.), using a tree structure. 
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Each category can be expanded or contracted using the small ‘folder’ icon next 
to the category (in the example below, Rules is the folder name). 

 
The page that is open is shown with a small arrow next to the category. 

Customise dialog changes 

The Customise option (on theTools menu) has been changed to allow new 
functionality. You can customise menus, add User tools to menus and toolbars, 
set up shortcut keys (Keyboard) in this dialog, create your own buttons and 
change some toolbar options. 

 

Customise menus 

Menus can be customised and named using your own names, they can contain 
your own set of commands. This is similar to toolbar customisation. 

From the list of Categories, you can select the New Menu option. This will 
allow you to add a new menu item to the menus. 
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When in the Customise dialog, dragging a new menu item over a menu bar item 
will cause the corresponding drop down menu to be displayed. While in a 
specific application (such as the PCB Design Editor), if the relevant menu isn’t 
displayed use the Menu tab and select the menu for the application required. All 
Pulsonix application types are available in the this drop down list. (see Menu 
Customisation later on). 

By right clicking on the New Menu name (while still in the Customise dialog), 
you can change the name of the menu item. 

You can edit the menu name by using the edit field Button Text on the Button 
Appearance dialog. This dialog also allows you to customise the button 
appearance. 
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The dialog is split into four sections: 

Choice of Appearance - At the top left of the dialog use the radio buttons to 
choose between Image, Text or Both.  

Description - Shows a description of the tool the button represents. This is not 
editable. 

Button Text - Enabled if you have chosen to show text on the button. Leave as 
the default option name, or type in your own text to display on the button. To 
reset the button to use the default option name, use the Reset To Default option 
from the shortcut menu. 

Button Image - Enabled if you have chosen to show an image on the button. 
Choose between using the default image (shown next to this option), or using a 
user defined button image, in which case the user image palette will be enabled 
to allow you to select one. An initial set of images are provided, but you can alter 
these or add new images using the New and Edit buttons next to the image 
palette. When either of these buttons are pressed the Button Image Editor 
dialog is displayed to allow you to create your own image. 

User defined icons for commands 

With the Customise dialog open, the button options on the shortcut menu for a 
selected option are used to configure the appearance of the button on the toolbar 
or menu. The Delete option is an alternative way of removing the button. The 
Start Group option is an alternative method of creating groups of buttons, when 
selected it will add a separator. It will be ticked on the menu if the button has a 
preceding separator to define the start of a group. 

 
Once the Button Appearance option has been selected, you can add and edit the 
icon as required. 

Menu Customisation 

The Menu page on the Options dialog allows the menus for a different type of 
design to be displayed, allowing them to be customised. You can add and edit 
menus to contain your own selection of commands and options. Each menu 
design type can be selected for editing regardless of which application you are 
currently in. 
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The Reset button will reset the selected menu back to its original default 
settings. Any user customisation will be lost. 

The Menu animations list box specifies the type of animation effect to be 
employed when a menu is displayed, for example, the menu can be shown to 
slide out when selected. 

The Menu shadows check box specifies whether or not a menu is displayed with 
a shadow. 

Adding User Tools 

You can use the Tools tab to add external tools, such as your text editor, to a 
User Tools sub-menu at the bottom of the Tools menu. Adding external tools 
allows you to easily launch other applications while working in the integrated 
Pulsonix environment. You can specify arguments and a working directory when 
launching the tool. User reports can also be run using this mechanism. 

 
The small buttons across the top of the dialog adjacent to the Menu contents: 
text have the following functionality: 
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Use the New (Insert) button to add a new tool, this will add an empty entry at 
the end of the list. Edit this entry in the list to specify the name of the tool. This 
name will appear on the User Tools sub-menu on the Tools menu.  

The order in the list is the order the tools will be presented on the User Tools 
sub-menu. Use the Up and Down buttons to re-order the list.  

Use the Delete button to remove a tool from the list.  

Select an entry in the list to change its tool details. Use the Command box to 
provide the name of the application to be run. Enter the path to the .exe, .com, 
.bat, .cmd, or other file that you intend to launch. Use the browse button (a box 
shown as …) to find the required file using a standard file browser.  

Use the Arguments box to provide any command line arguments that you need 
to send to the program when launched. Use the right arrow > button to the right 
of the argument edit box to drop down a list of plug in arguments. The chosen 
plug-in argument will be added to the argument field at the current cursor 
position. This argument will be expanded when the tool is run to contain the 
relevant information. In the example above the command line is 
"MyGerberViewer $(DesignDirectory)\$(DesignName).gbr". When the tool is 
run the command line will be changed to include the current design. e.g. 
"MyGerberTool c:\myfolder\board1.gbr". Use the Run Report argument to 
place the name of the user report file , specified below, into the command 
arguments to be used to launch the tool.  

Use the Initial Directory box to specify an optional working directory for the 
tool.  

The Run User Report field allows you to select a user report from the drop-
down list to run before the tool is launched. if you leave the Command field 
blank, only the user report is generated. This is a way of putting your user reports 
on the User Tools menu and assigning shortcut keys to them.  

By using the Run Report plug in argument with your tool, you can write a user 
report to generate the format required by your tool and automatically generate 
the report prior to running the tool and pass its filename as an argument to it.  
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Personalised menus 

An Options tab in the Customise dialog allows you to change options specific to 
menus and toolbars. 

 
Show ScreenTips on toolbars specifies whether or not tooltips are to be shown 
when the mouse pointer is over toolbar buttons. 

Show shortcut keys in ScreenTips on toolbars specifies whether or not the 
tooltips should include equivalent shortcut keys for toolbar buttons where 
defined. 

 
Large Icons enables toolbars to be displayed with the larger size icons. 

The default setup will be to not show full menus (see below), and so the initial 
menus will have some of the more advanced functions missing. These can be 
accessed by pressing the last entry of the menu or by un-checking the Show full 
menus after a short delay switch. 

The menus can be forced to be full size all the time by switching the check box 
Menus show recently used commands first off. 

Use the Show full menus after a short delay option to automatically change to 
the full menu after a short wait. 

Pulsonix now has a choice between full and short menus. 
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Short menus are chosen from the Customise dialog on the Setup menu. Use the 
check box, Menus show recently used commands first on the Options page. 

A short menu just shows the most recently used commands from the full menu. 
If a command is not used for a long time it will eventually disappear from the 
short menu. 

By clicking on the small circled arrows at the bottom of a short menu, the full 
menus will be revealed. 

Shortcut Keys 

The old Shortcut Keys option (in version 3.1) is now integrated into the 
Customise dialog, and is named Keyboard. This means that all interface 
customisation is located in one dialog. 

 
 

The shortcut keys report can now be sorted By Command or By Key: 
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Standard Menu changes 

There are minimal changes to the menus to declutter ones that may have become 
congested with the new options introduced. 

Menu declutter 

To declutter the menus, if only part of a Component or Doc Symbol is selected, 
the Reload Component and Edit Symbol/Footprint in Library options now 
appear on a sub-menu. 

 
Rotate One Step now appears back on the shortcut menus if the rotation step is 
not set to 90 degrees. 

The shortcut menus have been tidied up, so for example, Add To Net and 
Remove From Net have been added to the Nets>> section. 

Within the PCB design application, Optimise Nets, Unroute Nets and Add 
Teardrops have been moved from the Utilities menu to the Tools menu. 

In both the Schematic and PCB applications, Rename has been moved from the 
Tools menu to the Utility menu. 

All dockable windows are now on a sub-menu named Dockable Windows on 
the View menu. 
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Shortcut Menu changes 

Insert Spiral 

Insert Spiral is a new option and is available on the Insert Breakout and Insert 
Track shortcut menus. This option is discussed later in the Spiral Tracks section 
in the PCB Design chapter. 

Insert Rectangle 

On the Insert Rectangle shortcut menu, it now says Square instead of Free 
Movement when in this mode. 

Cross probe 

With an item(s) selected, the Cross Probe option now appears listed on the 
shortcut menu. 

Active Status Bar 
The previous Status bar has now been modified so that it now becomes an active 
status bar. This means that by double-clicking on a pane within the status bar, 
relevant information can be modified. For example, clicking on the Abs word 
will toggle between Absolute and Relative modes. Other modes, such as Grid: 
will display the Grids dialog where a change can be made. 

 
The Status bar items that may be modified are: 

 Layer, Layer Span, Net, Style (text style, pad style, line style) also 
editable by clicking on Width, Size, Line Width, Side, Delta X, Delta Y, 
Angle and Radius (for arc). 

 Units (mm/thou toggle),  

 Units (double-click on coords when not editing/moving item), 

 Typed coords (double-click on coords) 

 Absolute/Relative coords (toggle), 

 Current Grid 
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Find 

Item Finder renamed 

The Item Finder has been renamed to the Find Bar. This also uses the new 
style sliding when selected. 

New Find Items 

 
Find can now be used to locate Named Areas, unnamed Areas and Named 
Busses. Unnamed areas will only be found using the <Search entire design> 
switch but cannot be listed (because it isn’t named). Use the first and next button 
on the top of the option to locate them. 

You can now use Find to locate Doc Symbols (by Symbol Name and by using 
First/Next). 

Find Net in Schematics now also finds closed busses that include the net name 
selected. 

Find Vias is available in PCB either by net or all vias in design. Works in a PCB 
design and PCB Footprints. Using the shortcut menu, it allows you to select all 
vias in a net. 

Favourites 

Find Favourites has been added to the find bar. You can use Favourites for 
locating commonly used items in the design. 

The finder bar maintains a list of Favourite items, this list is saved with the 
design so you can keep track of items you often want to return to. You can add 
items to this list in two ways. Firstly, you can explicitly add an item by selecting 
it and using the Add To Favourites command from the shortcut menu. 
Secondly, you can check the Add Found Item to Favourites option in the find 
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bar shortcut menu. This will automatically add any items found using the find 
bar to the favourites list. You can limit the maximum length of this list using the 
Options dialog and Find page, Favourite List. 

You can remove items or clear the whole favourites list at any time using the 
commands available on the find bar shortcut menu. 

 

Refresh Option 

New commands Refresh Find Bar and Refresh Part Browser on their bars 
shortcut menus.  

 
This option is needed because not all ways of introducing design items update 
the Find bar. This is also available in the Parts browser because it does not 
always know of new and changed Parts. You can assign these options to shortcut 
key using Customise. 
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New Find options 

Find switches are available on the Options dialog and Find page. 

 
Other than some obvious actions on found items, one new choice is the ability to 
be able to Flash items that are found, and the length of time that the item is 
flashed. 

You can also can use shortcut menu in the Find bar to enable flashing of each 
item as you find it. Each of these options can be changed on this menu, these 
change the settings in the Options dialog. 

 

Note: Don’t make the flash item time duration too long as you will not be able to 
do anything else while they are flashing. 



 Pulsonix V4.0 Update   29 

Flash Find Items Commands  
Three new functions have been added to help you find items in crowded designs 
when using the Find options. 

Flash Errors, Flash Highlights and Flash Selection, these flash the appropriate 
items for the length of time specified in the Find options dialog. 

 

Report Maker Update 

Report Maker Dialog changes 

Colours in the command tree have been changed to reflect the different states: 
Comments are shown as green, Errors are shown as red, Disabled items are 
shown as grey and Control Commands are shown as blue. 

 
At the end of each command, a blank line is inserted to indicate the end of each 
level (as indicated below between the // Comment field and Else commands). 
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Drag and drop 

The command structure in the Format Script window now allows you to move 
items about by dragging and dropping the command. This significantly speeds 
up the use of the command structure. 

New and updated commands 

The Report Maker option has been updated to include new list items. 

List Of Layers and List Of Layer Spans have been added for use in 
manufacturing reports. 

New fields have been added for Error Marker Codes and Annotation. The code 
has been removed from the end of the Type field. If your report uses the existing 
Type field, you will need to modify it to add the new Code field as well. 

An Area field has been added for use with Pad Styles, Pads, Vias and Mounting 
Holes. Also added for these pad types is the Set Layer command. This has been 
added so that the pad area and total pad area can be calculated for paste mask 
pads but it can be used for other pad area calculations as well. 

List of Drills has been added. This can be used as an alternative for creating a 
user defined drill table. Other commands used to support this feature are Drill 
Table Units to change the report units to those of the drill table, Drill Table 
with sub-commands Step, Tolerance and Units Name. 

A new command of Design Units has been added to set the units back to the 
ones defined in the design. 

A new command for Drill Position has been added for Pad, Mounting Hole and 
Vias. 

A new command for testing Is Complete has been added for PCB Nets. This 
works the same way as the standard Net Completion report. 

CSV Command 

In the CSV command, you can now specify the separation character. Even 
though the option is called CSV, the output separation character will be the one 
defined in this dialog. By default the comma is used. 
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Angle & Coordinate Units 

On the Angle Units and Coordinate Units dialog, you can now specify the 
Decimal Point Character. The default will be a full stop but it provides you the 
ability to change this for your own. 

   

New commands for use with Embedded Components 

New fields have been added to the Report Maker to support the new embedded 
Component functionality. 

New fields for Layer - Are Comps Allowed, Are Comps Mirrored, Is 
Essential Class and Associated To Layer have been added. 

New fields for Components - Is Mirrored, Is Embedded Component and 
Layer have been added. 

New fields for Vias - Component Name has been added. 

List of Vias is now available on Components.  

Insert User Report 
There is a new option on the Insert menu to allow you to add a copy of a user 
report into the design. The report script is held within the design so that the 
report can always be updated without the actual format file having to be located. 
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User reports added to the design use the same defaults as the Drill table, both 
now use a new Default in the Design Settings dialog – Report Symbol. This 
uses layer, line style and text style for the defaults. 

To facilitate the insertion and management of user reports some new options 
have been added: 

Update All User Reports – located on the Utility menu, this option allows you 
update all the user reports when the design has changed. A similar command, 
Update User Report is available on the shortcut menu for a selected user report 
in the design. These commands are automatically run when the CAM Plot 
option is entered as well. 

Reload User Report – this is used to load a user report format file that has been 
modified. Care must be taken when using the Insert User Report feature, 
reports that are added to the design are added for the design in its current state 
and for the format file as it is. Both of these items are not updated automatically. 

Nets Reports 
The Nets Report for both Schematic and PCB now includes the number of pins 
in each net. 

For the SCM Nets Report, the report indicates if a net is in a closed bus, this is 
indicated as In Closed Bus. 

Select Mode 

Path Select 

There is a new option on the shortcut menu in select mode which allows you to 
select all segments in a shape or a track path between two selected points. If the 
selected points are in the middle of segments, they are split. 
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The path select mode can also be accessed by simply dragging along the line or 
track segment (provided you have this mode enabled in the Options dialog – see 
below). 

The process for inserting segments is to drag along a segment which selects part 
of the segment, and then drag the selected segment to create a ‘top hat’ shape as 
shown below. 

  
If you wish to select more of the shape, then simply drag further along the shape. 
Once the drag has been initiated and the shape segment picked up, the mouse 
movement will mimic the shape of the segment without having to follow it 
accurately. 

 
If you don’t want to drag to select the path, the Select Path option can also be 
used from the shortcut menu. 

New Options selection 

Within the Options dialog you can select the Interaction tab and enable or 
disable the ability to drag along shapes. You may wish to deselect this if you 
find that you are regularly dragging items which you do not intend to. 

 

Possible usage 

Uses of this could include: 

 Dragging segments in a track or line shape to insert a ‘top hat’ 
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 Unrouting a track between two points 

 Necking between two points (using the Select Path command followed 
by <S> Style to change the segment thickness) 

 Changes layer between two points 

Type Coordinate / Type Offset 
The two options, Type Coordinate and Type Offset, are now available on the 
selected items from the shortcut menu or by using a shortcut key when in select 
mode. These options can be used to reposition selected items directly without 
having to enter a move operation. 

 

Free Angle Segments 
The Free Angle Adjoining Segments is now available on Move. The switch to 
enable this option is on the Options dialog and Interaction for both Schematic 
and PCB applications. 

 

Component Bin Changes 
From within the Component Bin you can now make multiple selections of 
Components. Multiple selections can be made using the Shift and Ctrl key 
combinations. When multiple selections are made in the bin, no Component 
preview picture is drawn. 

From the design, if you drag multiple items into the bin then these will all be 
automatically selected in the bin. 

If using Move From Bin with the Component Bin containing multiple selected 
Components, each of the selected Components will be available sequentially as 
the current one is released. If nothing is selected in the bin or a single item 
selected, you get all of them sequentially on the end of your cursor. 

For multiple selected items in the bin, if you drag them out to the design they 
will all be on the end of your cursor. The actual item dragged will be on the end 
of the cursor and the others will be positioned along side it. 

With the changes made, if you use the Find Bar and use Select All Find Items 
using any selections or criteria in the find window, items in the design and in the 
Component Bin are selected. Previously, items in the Bin wouldn’t have been 
selected. 
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In Cross Probe mode, items selected in the Schematic design can now be probed 
even if in the Component Bin. This should make item selection and placement 
much easier. 

TrueType Font Preview in Selection 
Text in the Change Style drop down list is drawn in the TrueType font selected 
to preview it. 

 

Simulated True Type Fonts (True Scale) 
The Simulated True Type Fonts (True Scale) switch specifies how True Type 
text is to be drawn. This mode is setup in the Options dialog under Display and 
Simulated True Type Fonts (True Scale). 

 
The default system drawing of fonts is often not very accurate and can result in 
text strings which are drawn much wider at some scales. Checking this option 
ensures that the true type text is drawn and plotted at a consistent width. This 
may result in loss of detail particularly on intricate fonts. You can use different 
options for Schematics and PCB because you may want better detailed fonts for 
Schematics, but more accurately scaled fonts for PCB where the relative 
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positioning of items is more important. If you output to Gerber or Pen Plot, then 
the simulated true type will be used to produce the shapes required to plot the 
text. 

Control of Display of Part Name from Part 
You can now force the display of Part Name, Component Name, Pin Names 
and Logic Names from the Part. 

There is a new command in the Part editor on the Edit menu, Force Attribute 
Display which provides you with a dialog to force the display of the these 
values. 

 

Replace Part 
There is a new option on the Utilities menu to replace a Part used by selected 
Components. This is also available on the shortcut menu when the selection 
contains Components. 

Features 

 You can replace a Part on just the selected Component(s). 

 You can replace a Part on all similar Components in the design, page or 
block. 

 You can change the footprint to an alternative on Components using the 
chosen Part. 

You can get a report prior to performing the replace as verification. 

Repeat Last Command  
A new command to repeat the last command run has been added (Repeat Last 
Command). This is not in the user interface but is available as a default shortcut 
key assigned to <F4>. It is also available in the Run Commands dialog. For 
example, this is useful when having to re-enter an option dialog if you made a 
mistake, e.g. entering the colours dialog again.  
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Groups 

Set Group Master Item 

You can now select a grouped item in a loose group and make it the master item. 
This means that moving the master item will cause all the other items to be 
selected and move with it (similar to a tight group). However, the other items in 
the group can be moved independently. 

Add To Group 

You can now select multiple items and use Add To Group from the shortcut 
menu to add them all to a chosen group. This only previously worked for single 
items. 

You can also use this option in latch mode operation (select the option first then 
select the items to add to the group). 

Design Item Tooltips  
Tooltips are available when hovering over a design item to display information 
about the item. 

 
This is an optional feature and is controlled from the Interaction page of the 
Options dialog using the switches provided. 

 
 

Using the options available, you can check boxes to say what to include in the 
tooltip. There are separate options for Schematic and PCB applications. 

One option on this dialog is to include any attribute that is marked as a tooltip - 
Tooltip Attribute. Use the Attribute Names page on the Technology dialog to 
mark attribute names as tooltips (Use as Tooltips). 
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There is a new command, Design Tooltips On/Off to use for toggling tooltips 
on and off, this can be assigned to a shortcut key. 

Change Styles 
In select mode, you can now choose to apply track or via style changes to every 
track/via in the net. There is a new switch in the Change Style dialog called 
Apply to Whole Net. 

 

Library Creation from Part Information 
There is a new option Make Libraries to copy existing Schematic Symbols, 
PCB Footprints and Part libraries from the selected Part definitions in the Parts 
page of the Library Manager. 
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You can select an existing Part or Parts in the Part library listing and then using 
the Make Libraries option, can copy those Parts to a new Parts library (using 
the named list) along with the corresponding Schematic Symbols and PCB 
footprints. 

Library Contents Report 

New Report Options 

When running the new Library Report option from the Library Manager, it 
allows you to select from List Contents of Libraries to give you a list of the 
selected Library items (Symbols, Footprints or Parts), or to report a list of 
selected Symbols/Footprint items that are used in Parts libraries (use the Find 
Parts Using Selected Items radio button). 

 

Last Saved 

It will also now report the Last Saved time and date of the selected library or all 
libraries (depending on the selection). 

Single Line Attribute Value Editing 
When editing a Value Attribute, the value 3.3K on a resistor for example, you 
can now type in the new value, 3.6K, then press Enter <CR> for the value to be 
accepted and the dialog closes as though you had typed it and pressed OK.  This 
is more widely used on generic Components in the Parts library where the value 
attribute changes. 
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If you require a multi-line attribute then click the drop down button on the right 
of the list and type in the text into the extended text box. 

 

Note: This change also applies to normal Text. 

Picking Tolerance Value 
You can now set the minimum picking tolerance, this makes picking much easier 
in dense areas of a design. With this switch set, you will have to pick much 
closer and more accurately to select items in the design. 

This is set in the Options dialog and on the Interaction tab. 

 

Hyperlinks 
Some small changes have been made to the existing hyperlinks feature to make 
them more usable: 

Double clicking on a hyperlink attribute now launches the browser to follow the 
link. 

If a Part has the <hyperlink> attribute, the shortcut menu contains the Execute 
Hyperlink option. 

Integra Design and Library Import 
Using the Open or Data Transfer Wizard options, you can now import the 
Mentor® Integra format files. When you open a .txf file, this will open and 
import both the Schematic and PCB design files. 

Using the same files, you can also import .txf files into the library manager to 
create Symbols, Footprints and Parts. 
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Insert Circle & Insert Rectangle Changes 
The existing Insert Circle and Insert Rectangle options have been enhanced 
with additional functionality. When adding the circle or rectangle to the design, 
you can select the Define From Centre option from the shortcut menu. This will 
‘grow’ the shape being dragged outwards from the centre rather than from the 
start point edge. The Define From Centre option toggles between this and the 
normal mode. 

 

Set System/Relative Origin 
New options from the shortcut menu allow you to set the System or Relative 
origins on the selected item. The Set Symbol and Set Relative Origin 
commands are located on the Select> sub-menu for a selected item. 

Within the footprint editor these appear on the main shortcut menu but Set 
System Coordinates is replaced with Set Symbol Origin. 

 
These are also available as commands to assign to shortcut keys: 

Set Coordinate Origin 

Set Relative Origin 

Switch Between SCM and PCB Designs 
A new command allows you to switch between a Schematic and PCB design, 
opening the design if necessary. The command is called Switch to 
Schematic/PCB and can be assigned to a shortcut key. 
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Chapter 3. Schematic Options 

Bus Changes 
Closed busses can now be named if required. All busses that have the same name 
will have the same allowed net name set. Busses can be named through the Bus 
Properties dialog. 

 
When adding a name in the Properties dialog, if the bus is an unconnected open 
bus then you can choose from a list of closed bus names. 

If a bus is open and unconnected, a new option will allow you to select it and 
from the shortcut menu, select Change Bus. The selected bus will be changed to 
match a closed bus, taking it’s name and net names. 

 
The Change Bus option is also available in the Insert Bus and Edit Bus 
operations. 

One other small change to busses, you can now use the Find bar to locate busses 
within a design. Where a closed bus doesn’t have bus name, the bus will 
displayed using the net name range. You can use the Find Bus option to cycle 
through any separate sections of the same bus in a multi-page design. 



44   Pulsonix V4.0 Update 

Net Page Attribute 
A new default attribute <Net Pages> was added to the list of available attributes 
in Pulsonix during V3.1. This displays the pages that the net appears on and has 
Net Pages Attributes configuration switches in the Design Settings option 
naming the page (see below). 

When you use the attribute <Net Pages> anywhere on a net (using the Insert 
Attribute option), it will show a list of the pages that net appears on.  

You can configure how this attribute will be presented using the Design Settings 
option and Naming page. You can define a Prefix and the Separator between 
each page. You can choose if the current page is to be included in the list using 
the Show Current Page option. The page can be shown as a name or a sequence 
number using the Show Page Number option. For example 'Pages: Page1 + 
Page2 + Page4'. 

 
Pulsonix version 4.0 allows you to check that any net which has the <Net Pages> 
attribute displayed, must have it displayed on every page that the net appears on. 
The check is called Unlabeled Net Pages. 

 

Display of Part Names on each Gate 
On the Design Settings option, there is a new switch to allow Part Names to be 
displayed on each gate of a page or just on one of the gates on each page that the 
Part is on. When a Part name is displayed on one gate only, the first gate used in 
the design on that page will display the gate name. If the first gate is in the 
Component bin, then the next available one is used. 
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ERC Changes 

Pin type Warnings 

You can now add an error marker to the design to show Pin Type warnings 
using the ERC option. Pin Type errors are already flagged but this allows the 
warning status to be flagged as well. 

 

Default Block Port Symbols 
A new default on the Design Settings, Defaults and Block page has been added 
to define the Symbol for a bi-directional port using the bi-directional port symbol 
entry. The Add Block Port dialog now uses the defaults for port symbols when 
the pin type changes. 

 

Part Editor - Default Logic Names 
From within the Schematic Symbol editor, you can now specify Pin Logic 
Names for the schematic symbol. Previously, only the attribute place holder 
could be defined. When defined, these names are the defaults when the symbol is 
used in the Part editor. The Pin Logic Names can be edited from the Properties 
dialog of the selected Logic Name. 
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Apply Symbol Logic 

From within the Part Editor, there is a command Apply Symbol Logic Names 
available on the shortcut menu on the Logic Names column which resets the 
logic names to those specified in the schematic symbol. 

 

Pin Networks 
A Pin Network allows you to define additional Components to be connected to a 
pin. For example, you can automatically add bypass capacitors (like in the 
example below) or terminating resistors that are associated with another Part. 

 
There are two main processes to make the association: 

 For the Part that requires the association - add the Pin Network name 
on the Pin page of the Part in the Part editor. 

 In the design and in the Technology file, define a pin network name 
and add the Part Name to be used as the secondary Part. The 
Terminating Net name can also be defined if required. 

Terminology Used 

We would consider the main Part (the Part to be decoupled) to be the ‘host’ and 
the Part used for decoupling, to be the ‘secondary’ Part. This is how they are 
referred to in this text and in the online help pages. 

Reasons for using pin networks 

 To ensure you have enough bypass capacitors defined in your 
Schematic. 

 To aid checking the PCB to ensure that these capacitors are close 
enough to the ‘host’. 
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 To aid laying out the PCB to keep associated Components close to the 
‘host’. 

Creating Pin Networks 

 To create a pin network  

1. You must add the Pin Network name on the pins of the ‘host’ Part (the 
main Part in the Part Editor that will use the secondary Part). 

2. Edit the host Part and select the Pins page. 

 
3. The Pin Network name is just a name that can be recognised when doing 

the next process. It is used as a reference when this Part is used in a design. 

4. Save the Part. This is all that is required in the Part editor. 

5. In the Schematic design, define the Name of the Pin Network Part in the 
Technology file using the new Pin Networks tab.  

 
6. When this is done in the Schematic it is automatically transferred to the 

PCB design during Translate to PCB. 



48   Pulsonix V4.0 Update 

7. The name of the pin network should match the name used on the Part pin, 
this is essential. 

8. Using the New or Edit Pin Network button, you can define the net which is 
connected to the other end of the network, either by name, by net class, or 
to be prompted for a pin to connect to (End On Pin). 

 
9. When a Component is added to a design, the pin networks are matched with 

those defined in the Part pins. Any which have not already been defined can 
be defined as the Component is added.  

10. The Components in the pin network are added to the component bin in a 
special section for connected Components (in the previous release, all 
Components in the bin were not connected). 
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11. You can drag these Components from the bin and they will , provided their 
nets are in scope according to the parameters set. You cannot place 
connected Components into the bin. 

When the design is transferred to PCB, the pin network Components are also 
transferred and set up in a loose group with the host Component set as the 
‘master’ item. This way, moving the host moves the associated Component. 

PCB Design Editor 

In the PCB design, the Autoplace option will attempt to place the pin network 
Components as close as possible to their master Component. 

The DRC option will report any pin network connection length fails. 

When routing a Pin Network connection with a length restriction, the 
Interactive Net Length Indicators are shown (see later in the PCB Design 
chapter). 

Highlight Bus Net Pins 
A new command Hightlight Bus Net Pins has been added to highlight the pins 
on the nets defined on the selected bus. This is available from the shortcut menu 
of a selected bus. 

 
This is particularly useful after using the reverse engineering tool. (See next). 

To remove the highlight, click in free space and use the Remove Highlight 
option from the shortcut menu. 
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Reverse Engineer 
Within a PCB design, it is now possible to take your PCB and reverse engineer it 
back to create a new Schematic design.  

 
The Reverse Engineer dialog allows you various options and selections to be 
made when the option is run. 

 
Components can be added to the Component Bin in the Schematic design. The 
bin is divided between unused and used gates, you should place all the used gates 
onto the Schematic pages to complete the design. 

 
Components in the PCB design that are flagged as PCB Only Parts are not 
reverse engineered. If you wish to reverse engineer them they need to be edited 
in the Part editor and Schematic symbols added, then use the Reload option to 
reload them updated Parts to the design. After this you can use the Reverse 
Engineer successfully. 
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For Components that don’t have a Parts library entry (because they came from an 
external source for example), these Components will be reverse engineered but 
the Schematic Symbols will be automatically created for you. The shapes of 
these Symbols will be generic boxes and not the real shapes. 

Schematic Routing 

When the Unplaced Components to bin check box is not selected, Components 
are placed in the design using their relative PCB design positions and using 
suitable placement spacing. 

Having this box unchecked enables you to also select the Route Connections 
check box. Once the design has been placed in the Schematic the connections 
can be automatically routed using the Schematic connection router. 

 

Sketch Connection 
The Sketch connection path mode has been introduced into the Schematic design 
editor. This allows you to interactively make a connection between two points 
using a basic ‘sketching’ mode, or by using a point-to-point mode. 

Using the Sketch Connection mode from the Insert menu, you can add 
connections to the design. Once in this mode, this is verified by the display of a 
modal cursor, a cursor which shows a mode. 

 

This picture shows the 
approximate path that you 
‘sketch’ in. The modal cursor 
is also shown. 

 This picture shows the final 
result after completion and 
tidy-up. 

 

Immediately after using sketch mode, the tidy routine will snap the connection 
onto the grid and remove all the rough edges for you. Once added, the 
connection path can be tidied up using normal connection editing options. 
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Shortcut menu options 

While using the sketch mode, you can use options form the shortcut menu. 

 

Point to Point mode 

On the shortcut menu, you can select Sketch Track Point To Point mode. This 
allows you to point and click to add a connection path. After the mouse click, the 
path will be tidied back to the last click, this gives you a ;guided’ routing path 
which is automatically tidied as it goes along. This may be a preferred mode of 
operation to the normal sketch mode. 

Connection Options 

The Options dialog and Interaction page now allows you to use drag or double 
click to add a connection from a pin on a net with no connection. This is 
particularly useful for reverse engineered designs. The default is drag to sketch 
and double click to use normal add connection. The default sketch mode is point 
to point. 
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OrCAD Export 
From within the Pulsonix Schematic environment, you can export an OrCAD 
EDIF file containing the whole design in graphical format. 

Using the Save As option on the File menu, select the Orcad EDIF Schematic 
Design (.edf) option from the drop down list , the design is output in EDIF V9.2 
format. This can be read into V9.2 and later versions of OrCAD Capture. 

 
All trademarks acknowledged to their rightful owners. 

Show Net Name 
For a selected Net in Schematics, the shortcut menu now says Show Net Name 
or Hide Net Name depending if one is displayed on selected item. 

 
There is also an option on the Schematic Utility menu – Show Net Name. This 
option can be latched down, use it from the Utility menu with nothing selected, a 
modal cursor is displayed. You can then select items interactively to show or 
hide their net name. 

Automatically Display Required Net Names 

Whilst using this latched mode, from the shortcut menu item you can use Apply 
To All to ensure that a net name is displayed on each subnet of a user named net. 
The net names newly displayed are highlighted to make it easier for you to find 
them to reposition.  
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Cross Probe 
You can now select Block Instance Symbols in a Schematic design to select all 
the Components in the PCB Design that appear in that block. 
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Chapter 4. PCB Options 

Footprint Creation 

Component Vias 

You can now add Component Vias to footprints. These have been introduced to 
facilitate the embedded Component technology (see later in the Embedded 
Components chapter). Component Vias can be added to any normal footprint as 
well. 

Once added Properties of the Component Via will allow you to set a flag for 
No Spacing Check Within Footprint so that two pads on different nets can be 
joined together (for an embedded resistor for example) through a via without a 
DRC check rule violation being displayed. 

 

Footprint Copper 

Copper within the footprint editor also has the No Spacing Errors Within 
Footprint check box available. 

Areas 
The Properties of Areas have been enhanced to add new options. These allow 
Copper Keep Outs, Drill Keep Out, Power Plane Avoid, Set All Keep In and 
Board Cutouts. 
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Named Areas 

You can Name an Area and select whether the name is displayed on the design. 
Using the Find Bar, you can find a named area. Named areas can also be chosen 
when using the CAM Plot option to only plot that area. 

It can also be used in Autoplace to place selected Components in the Named 
Area. 

Keep Out Types 

Areas can be created so that they avoid power planes, thus creating gaps in the 
plane (using Power Plane Avoid).  

 
This is used where the layer bias is defined as Powerplane in the Layers dialog.  
These areas can be defined in a design, in a Footprint and as <Through Board> 
(for all layers). Copper Pour Keep Out is still a separate area type but both can 
be specified for an area. 

 
Copper and Drill Keep-out areas have been added. Copper includes pads and 
text but not vias, component vias or tracks which have their own area Keep-out 
type. Drill Keep-out areas include all drilled items but only the actual drill hole 
is checked, not the surrounding pad. These area types are particularly useful 
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when etched resistors are defined so that holes and copper are prevented from 
breaking the resistive material. 

A single button has been added in Properties to allow you to set all area types to 
Set All Keep Out or Set All Keep In on this dialog. 

Board Cutout Areas 

A new area type of Board Cutout has been added. This can be used to add a 
separate cutout to a board. This will be particularly useful if the cutout in a board 
needs to be processed in a different manner, such as plated through or 
punched/routed out. This area type is available in Footprints so that slots can be 
defined for Components. This area type can only exist on the <Through Board> 
layer. A Board Cutout can be defined as Plated or left unchecked, as not plated. 

Board Cutouts Areas can be made plated and/or unplated by using the Layer 
Class option within the Technology dialog. These can be used to create slots in 
Components. These can be selectively displayed as well through this dialog. 

 

DFM Rule Changes 

Minimum number of spokes 

It is now possible to specify the minimum number of spokes that are used for a 
thermal pad connection on a full powerplane (in addition to poured copper). 
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This provides the program with an opportunity to add an exact number of spokes 
but to also have a tolerance if it cannot add the specified amount. 

Thermal pad rules 

Thermal pad rules can now be defined for a sub-net of a net class. This can be 
defined by using an Attribute (a user defined attribute) or by using one of the 
Additional Rules for Vias, Through Hole, and Surface Mount pads. 

 
In order to be able to specify a Thermal Pad Rule, you must define a Rule 
Level Net Class rule and use the Net Class Override check box for the selected 
Net Class. Once the Net Class Override check box has been selected, you can 
then use the Additional Rules button to add the rules. 

 
When the Net Class is used, any rule defined will be applied to it. This can 
either be on selected pads or vias on a net where an attribute has been added to 
apply the rule, or more generically using the rule types (Surface Mount Pads, 
Through Hole or Vias). Combinations of these types can be used on a net class. 
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If the rule applies to an attribute, you must select that attribute from the list of 
attributes that exist in the design. An attribute can be used to define a specific 
sub-set that requires an additional thermal value. 

 
Once a rule has been selected from the list or the attribute selected, use the Add 
button to apply the rules. Clicking the Add button will allow you to define the 
parameters of the rule (these are greyed out before the rule is defined). Create the 
parameters for the rule and click the OK box to save it. 

The DFM/DFT Rules dialog will show you that a rule has been defined for any 
selected net class with the X Currently Defined words. 

 

Design Rules Check 
New rules have been created to check the following: 

Spacing – Components (to Board), this checks for Component, Via or 
Testpoints being completely outside the board. 

Manufacturing – Plane Thermal Pad, this checks that thermal pads in a power 
plane have the minimum number of spokes connected to the plane. 

Manufacturing – Component Name, this checks that the component Name is 
not closer to another Component than its owner. 

Manufacturing – Minimum Land Size, this checks that a pad has the correct 
proportion of pad land to drill hole ratio. This is defined in the Technology 
dialog under Spacing Rules. 
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A new check to check that Vias or Testpoints that are completely outside a 
Board Keep-In/Out area are marked as in error. 

In PCB Footprints, a new check will check that the Symbol Origin is on the same 
grid as the pads. (So the pads stay on the grid when the Component is moved). 

DRC changes 

You can now DRC items on the same net. This rule is set on the Technology 
dialog under Spacings and Net Class. This will flag items not explicitly 
connected which are too close. You must set the Rule Level to Net Class for this 
rule to be available. 

 
Only Tracks, Pads, Vias etc. are checked (copper is not checked). Tracks must 
connect directly to a pad (no corners inside the pad). 

You can specify the minimum pad undersize in the Layer Class dialog (for 
example on a Paste Mask layer) using the Min Undersized Pad entry. This can 
be checked with the DRC option in the Manufacturing checks using Pad 
Undersize. 
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Error checking within a footprint 

A copper shape or Component via in a footprint can be marked to be excluded 
from spacing checks with other items in the same footprint. This allows copper 
to connect two pads together whilst the pads are on different nets (for example, 
copper in a spiral inductor or a via in a vertical resistor). 

To activate this feature you must check the No Spacing Errors Within 
Footprint box in Properties for the selected item. 

 
This allows you to still run a DRC check in the Footprint while designing it so 
that genuine errors can be flagged. There is an option on the DRC dialog to 
check Excluded Items. 

 

Template Properties 
A template can now specify an alternative Net Class for thermal pad and spacing 
rules. 

 
By selecting the Override Net Class button, you can specify an alternative net 
class to use for the selected template. 

This can be used for low power or digital sections of a net where different 
thermal pads are required. 
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Copper Pour Check 
When using the Copper Pour option, it now does a check when adding copper 
that the thermal spokes are added following the new DFM/DFT rule defined for 
minimum number of spokes. 

CAM Plot Changes 

NC Drill changes 

NC Drill Output 

The NC Drill option now reflects the drill table to define the tolerances for drills 
used.  

Drill tolerances 

The Drill Table dialog has been enhanced so that the you can define drill 
tolerances either as Allowed Drill Sizes and/or by using the existing method of 
Tolerances and Steps. 

 
The Define Allowed Sizes dialog will enable you to specify drill sizes that are 
acceptable to your manufacturing process. This enables you to refine the drill 
sizes based on actual available or recommended drill sizes. The Reset button will 
regenerate the table, setting default values and removing drill sizes which are not 
referenced in the design. 
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Drill sizes shown outside the allowed drill sizes will be highlighted in red on the 
dialog. 

The drill table dialog gives you a summary of how many matching drill holes 
and the range of sizes which match after step and tolerance have been taken into 
account. 

Routing profiles 

The Excellon output has been enhanced to allow routing patterns to be output. A 
routing output is used where a board outline is profiled to remove it from the 
panel that it is manufactured in. It can also be used to create a routed slot in the 
board. 

This is achieved by selecting a Process layer other than Layer Span <Through 
Hole>, Board for example, and by selecting Output as Excellon.  For best 
results, create a Board layer that has just the option for processing. By only 
plotting the board it is possible to get a routing output. 

 
On the Output page, select the Style as Outline. Normally for NC Drill you 
would select Drill as the Style. 

 

Windows Verification plots 

When using a Windows verification plot (selected from the Gerber Setup page), 
you can specify whether the plot is actual size or auto-scaled to fit the page size. 
The verification plot is centred on the paper. 
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Plot changes 

You can now plot using named areas. The plot dialog has been changed so that 
you can specify the alignment with area, design extents, working area and board 
extents. 

 
You can include the Variant Name in an output file name. You can use any 
combination of Design Name, Variant Name and Plot Name. 

Save Settings 

You can Save and Load device settings to file on the Plot Settings tab of the 
CAM Plot dialog. This allows you to create device ‘profiles’ for the different 
devices available. For example, the Gerber device can be saved in 3.2 or 4.3 
formats using device files. Device files are saved with the file extension of .plt. 
These files can be sent to your manufacturer to ensure that the settings used are 
accurately reflected in the plot. 

 

Registration point values displayed 

From within the Preview window the Registration point and Plot Area sizes 
(width and height) are displayed. 
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Negative Windows Plot 

Windows plots can now be negative. Previously this wasn’t available. From 
within the CAM Plot dialog, on the CAM Plot wizard, Output page, you can 
select between a Positive Plot and Negative Plot. 

 
The Negative Plot output would be exactly the same as if for a positive plot 
except that it is reversed. This may be required for some less sophisticated 
manufacturing processes. 

The resultant plot looks like this: 

 

ODB++ Output Changes 
Two new check boxes have been added to the ODB++ dialog to enhance its 
operation. 

The Use CAM/Plot Layer Combinations check box means that instead of 
outputting data for every layer in the design, it will output data for each Gerber 
and Excellon type plot defined in the CAM Plot page of the Technology dialog, 
this includes multiple combine layers. 
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Some viewers have problems with reading the netlist associated data in ODB++ 
files (a non-Valor viewer). So if the viewer you are using will not read the 
ODB++ data output (which will include netlist data), uncheck the Output 
Netlist Data option.  

GenCAD Output 
The GenCAD output uses version 1.4 format. This is a manufacturer specific 
output for driving test and production but is also used by the Fabmaster product, 
Polar Instruments products and other systems. 

 
The Settings option allows you to specify the attribute used to identify the 
Fiducial markers in the design. These must be manually attached as attributes by 
you during the design process. 

IDF Output 
The IDF Output dialog has been changed to allow you to select the Component 
Outlines Layer Class. 

 
This can be used to select which layer class is to be used to choose the 
Component outline shape. The largest closed shape on a layer using the selected 
layer class is used as the Component outline for each component. If no layer 
class is selected, all shapes on non-electrical layers are considered. 

Auto Mitre/Unmitre 
There is a new option on the Tools menu, Auto Mitre >. This is used to add and 
remove mitres in tracks, this is also available on shortcut menu for a selected 
track. 
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Mitre 

You can set the auto mitre parameters by using the Auto Mitre All command, or 
the Auto Mitre Parameters command. 

 
Use Curved Mitres to insert an arc instead of a line for the mitre.  

Use Any Angle to allow mitres to be added to non-orthogonal (not 90 degree) 
corners. Normally only 90 degree corners are mitred.  

Maximum Mitre Size - This is the maximum mitre offset in the X or Y 
direction, not its length. Mitres are usually added using this size, but if the 
adjoining segments are short it will add the largest size it can fit in.  

Minimum Mitre Size - When the maximum size cannot be used because the 90 
degree segment is too short, a smaller mitre will be inserted. This parameter 
makes sure that the mitres do not become too small.  

Note Mitres are only added where they will not cause design errors.  

Unmitre 

The Unmitre tool will attempt to remove mitres. It analyses the corners and will 
identify segments which could have been added by the mitring tool (it uses the 
mitre sizes set in the Auto Mitre parameters as a guide). The segments identified 
as mitres are removed. The segments are only removed if removal will not cause 
design errors.  

Auto Track Smooth 
There is a new option on the Tools menu, Auto Smooth>, this is also available 
on the shortcut menu for a selected track. 

This is used to smooth existing tracks. This command will attempt to remove 
corners and vias from a track path whilst retaining the connectivity and not 
introducing any design rule errors. 

Changes to Dimensions 

Dimensions in footprints 

Dimensions can be added and saved in Footprints. When added to the PCB 
design, if the layer used for the dimensions exists in the design then the 
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dimensions will be added. If the layer doesn’t exist, the dimensions will not be 
added. The latter may be a useful option for adding additional footprint 
documentation for use within the Footprint editor only. 

Prefix Text in Dimensions 

You can now add a prefix to the dimension text used. There are separate defaults 
for Angular, Radial and Length dimensions. Radial dimensions can now have a 
different default unit to that of other length dimensions. 

When using prefix text, you should add a space character after the text so that 
when used, it spaces the prefix from the dimension. 

 
These text prefix can be defined in the Design Settings option under Defaults 
and Dimension Units. 

 

Snap Dimension To Arc Centre 

When using linear dimensions, you can now snap to the centre of an arc using 
the Snap to Arc Centre on the shortcut menu. By selecting the arc, the 
dimension will automatically select the arc centre. 
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Radial Dimensions 

Inward style radial dimensions now behave more consistently when the label is 
moved to the inside of the arc. The dimension will 'pivot' about the arc centre. 

Layers Dialog Changes 
Within the Technology dialog, the Layers page has changed. The dialog is 
formatted as before but there are separator lines to clarify each class category, 
e.g. Electrical, Documentation etc. 

Changes have been made to the Layers dialog grid to support the addition of 
inner layer ‘sets’. Pulsonix already has <Top Side> and <Bottom Side> layer 
sets, and you can now add <Inner> layer sets. The Inner layer sets are used for 
embedded Component technology and allow association of non-electrical layers 
with inner electrical layers, e.g. resistive material layers. 
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The dialog now shows The Number of Electrical Layers at the bottom of the 
layers page. 

The Colour column has been removed (layer colours can be changed in the 
Colours dialog as before). 

The Layer Names column has been split into two columns - Name and 
Associated Layer. The second column is used to hold names of layers that are 
‘associated’ with a layer set. So for example, a Top layer might have associated 
with it, Top Silkscreen, Top Paste, Top Wire etc. 

 
Further changes have been made to enable the Embedded Components 
technology, this is detailed in a later chapter headed Embedded Component 
Technology. 

Layers Bar 

Categories button 

From within a PCB design, the layers bar contains a More>> (Hide<<) button. 
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This button displays the Show and Pick switches for six electrical PCB item 
categories. If you do not want to use these categories then use the Hide<< button 
to hide the switches from the bar. 

Each of the boxes uses a quick method of switching the appropriate options in 
the Colours dialog. These check boxes represent multi items in the Colours 
dialog, not just the item shown. For example, Routing represents Tracks, 
Breakouts and Vias, Pads switches off all Pads and Mounting Holes. The state 
of the switch is based on the ‘main’ colour item category, e.g. Tracks for 
Routing, etc. 

Show Items Layers 

There is a new option on the shortcut menu in the Layers bar, Show Item 
Layers. With a layered item selected in the design, this option becomes 
available.  

 
When the option is chosen, the layers on which the selected item resides will be 
switched on and all other layers switched off. This is also available as a 
command for assigning to a shortcut key. 

Clear All Templates Command 
A new command Clear All Templates (run from the Run Command option on 
the Edit menu) has been added. This means that as a command, you can now add 
this option to a shortcut key. 

Obstacle Avoid Mode 
The Obstacle Avoid option is available on the shortcut menu for use when 
adding and editing tracks. When used you are then using a special mode of 
routing. In this mode the track will automatically add a corner and change 
direction when you hit an obstacle.  



72   Pulsonix V4.0 Update 

 
In  obstacle avoid mode you can automatically remove any corners that have 
been added by retracing the cursor back over the track (like in auto corner).  

This mode applies to either segment being dynamically moved. This has the 
result of being able to ‘wrap around’ obstacles without having to interactively 
add corners. The track to item spacing rule will be used in this mode. 

 
Using this mode you must have the Online DRC option enabled as well. The 
Obstacle Avoid mode is available on the shortcut menu under Editing Options> 
when editing a track. Also available on the Options dialog under Edit Track. 

Track Hugging 
During track editing, there is a new interactive editing feature that allows you to 
add a track that hugs another track or design shape as closely as it can.  

The feature is particularly useful when adding bus routing patterns and track 
shielding. 

 To use track hugging mode  

1. Start adding new track segments, or edit an existing track. 

 
2. Move the cursor over the track or shape edge that you wish to hug.   
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3. Right click the mouse and use Start Track Hugging from the shortcut 

menu. A better way to do this is to put the Track Hugging command onto a 
shortcut key and press the key when the cursor is over the track to hug. 

 
4. A modal cursor is displayed to confirm that the track hugging mode has 

started. If there was no track under the cursor when the mode was selected, 
pick the track to hug at this point. 

5. As you move the cursor along the picked track or shape, the new track is 
added alongside it. The spacing rules gap is used to avoid design rule errors.  

 
6. Press the left mouse button to add a corner to End Hugging and move away 

from the shape. Selecting the Track Hugging command again will also stop 
the hugging mode. 
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Polar Grid Coordinates 
Polar grids are used to place items that require a radial grid rather than a regular 
linear grid. 

For a polar grid, check the Polar Grid box in the Grids dialog.  

 
You can define polar grids using the Radial Steps count and Concentric Step 
under the Step box. Once the Polar Grid check box is selected, you should then 
define the number of Radial Steps. For example 8 radial steps would give one 
every 45 degrees, radiating from the origin. The Concentric Step is the gap 
between each concentric circle around the origin. The origin Angle is the angle 
of the first radial, this effectively rotates the whole grid about the origin. For 
relative polar grids, only the grid origin position is relative. 

 
Use the grid Origin to position the grid centre in the design, usually this would 
be the board centre on a circular PCB. 
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Using the three buttons available, you can choose to set the X and Y grid origins 
onto the Board Centre, Coordinate Origin or the Relative Origin. 

If you zoom out too far, a ‘rough’ polar grid is displayed. This allows you to still 
view the polar grid but in a much rougher form until you zoom back in again. 

 

Auto Rotate when moving Components 

When interactively moving Components and Text on polar grids, you can use 
the Auto Rotate switch in the shortcut menu. The next move of a Component 
remembers this setting. This means you can easily move Components snapping 
on the polar grid but also rotating them to maintain the grid position. 

 



76   Pulsonix V4.0 Update 

Placement Sites 
To aid the manual placement of critical items, you can now nominate Attribute 
Positions to be placement sites. A new dialog under the Design Settings called 
Placement Sites can be used to define the name of the attribute to be used. 

The check box Use Attribute Positions As Placement Sites activates this 
special placement option. 

 
With the PCB design, when moving an item, the option Toggle Placement Sites 
is available from the shortcut menu. 

The Attribute Positions act like extra grid points and the cursor will snap to 
these. 

DXF Import - Placement Sites 
When importing into a PCB design, it is possible to generate Placement Sites 
from 'crosses' in the DXF data. Placement Sites are attribute positions in the 
design, that can be used to 'snap' Components onto particular locations on the 
board.  
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If the Placement Sites checkbox is ticked, the design will be examined after 
import and any crosses (two single segment shapes of the same size that cross at 
90 degrees to each other) will be marked with the specified attribute position at 
the point the lines cross. The Attribute name and Layer Name are specified in 
the Settings dialog. 

 
The layer to be checked for crosses, and the attribute name to use, are specified 
on the Placement Site Settings dialog. The attribute used should be added to the 
list of Placement Site attributes in the Design Settings dialog. 
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Plane Isolation on a Track 
For a track on the same net as poured copper or a powerplane, you can specify if 
it is isolated or not, in a similar way to pads. This overrides the Technology 
option. This is on a per-instance basis for track. The Avoid Same Net option is 
for all instance. 

Use the Properties dialog for a selected Track. You have the choice of Default, 
Isolated and Not Isolated. 

 

Drawing Drill Holes 
You can choose to always draw drill holes, even when the layer classes have 
turned them off. This means that you can see the holes while designing, without 
changing the layer classes. 

This is available from the Options dialog and Display page as Draw Drill Holes. 
You can choose Never, By Layer Class and Always 

 
The Draw Drill Holes preference is only relevant to designs which can contain 
drill holes (e.g. PCB). It only affects drawing to the screen and not post 
processing. Redrawing speeds may be slightly enhanced by turning off drill 
holes (Never). The default is to draw drill holes when a displayed layer has a 
class with drill holes shown (By Layer Class). You can also choose to always 
draw drill holes when a pad is drawn (Always). 

Import Design Data/Export DXF in PCB Profile 
From within the Import Design Data option on the File menu and while editing 
PCB Profiles, you can now import DXF files into PCB profiles. This 
information can also be saved in the Profile files. 
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‘Where used’ Indicator 
The ‘where used’ indicator has been changed to make it more obvious. Within 
the Reports, the Drill Table and Technology, a ‘Y’ is used to imply used/true, 
this has changed from an 'X' used previously. 

 

Colour Dialog Changes 
From within the Colours dialog and on the Layers page there is a new option on 
the shortcut menu. Apply to this side will allow you to apply the Displayed and 
Selectable settings to all pages in the Colour dialog. 

 

Sketch Track 
A new option on the Insert menu allows you to very quickly add a PCB track 
following a particular path. You sketch in a rough track path and it is converted 
to a tidy track that is as close as possible to the sketch, but avoids producing 
errors.  

  

The track is drawn in after selecting 
Insert Sketch Track. 

When the track path has been 
drawn, the mode tidies it up and 
optionally adds mitred corners. 
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Shortcut menu options 

While using the Sketch mode, from the shortcut menu you can change the 
options available. 

 
Use Any Layer allows you to sketch a track path which can be routed on any 
track layer, the current layer is used if possible, but vias can be added as 
required. Otherwise, the tracks will stay on the layers they were sketched on.  

Sketch On Grid controls if the sketch is to be completely free hand or gridded 
(using the Track Grid). 

The Mitre Result option causes the resulting track path to be mitred using the 
Auto Mitre tool and the parameters defined. 

Rather than sketching a rough continuous path, the Point To Point mode allows 
you to define a more exact path. A track is drawn between the first point (using a 
mouse click) and the next selected point (also on a mouse click). 

The shortcut menu switches are reflected on the Options dialog, Edit Track 
page under Sketch Track. 

 
The most effective way to use this mode is to point and click, the click will 
immediately enable the tidy function. Click at the next point required and 
another tidy will be done. This process will give you better overall results. 
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Auto Correct Track 
A new option on the shortcut menu when editing tracks, Auto Correct Track, 
allows you to correct a PCB track that is in error. It will automatically move and 
change the layer of the track segments to avoid obstacles. You can use the Auto 
Correct Track option in the Options dialog under Edit Track to decide whether 
the result is to be mitred or not. 

 

Apply Layout Pattern 
There is a new option on Tools menu (in PCB) to take the layout pattern 
(Component positions and tracks paths between Components) from a set of 
Components and apply it to a different set of Components.  

Recommended Uses 

This option is ideal for repetitive circuits such as RGB drivers for example, 
where one ‘channel’ is defined, placed and routed. Then the other two channels 
are ‘copied’ using this tool. 

It is also useful where you have a previous layout defined and wish to apply that 
circuit to the current design. This type of circuit may be particularly EMC or 
high-speed sensitive where the layout is critical. It may also be that because of 
compliance testing, the circuit has been approved and hence the layout pattern 
must be maintained. 

How To Apply A Layout Pattern 

If you wish to apply the pattern to a particular set of Components, first select 
them in the design (they must be fully selected using the Shift key), or select 
them in the Component bin. You do not need to do this if they are all in a named 
group. Note: You can use the Find Bar to easily select a set of Components 
with a common name stem, or sharing a common attribute value. Also, you can 
use the Cross Probe option to select the Components to apply the pattern to in 
the schematic design. For example, selecting a block symbol in the schematic 
will find all Components in the block and select them in the PCB design or 
Component bin.  

The Apply Layout Pattern dialog is displayed. 
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The dialog allows you to specify where to get the pattern from and which 
Components to apply it to.  

This includes ability to take pattern from a different PCB design, which allows 
you to save patterns to PCB files for use later. 

Take Pattern From 

Choose where to find the completed Components which define the layout pattern 
(Component positions and track paths) to be used.  

 Selected Components - Copy the pattern from the selected placed 
Components.  

 Clipboard - Copy the pattern from the Components that have been 
copied to the clipboard. This is a good way to copy the pattern from a 
set of Components in another design.  

 Group - Copy the pattern from the Components in the same design that 
are in a named group.  

 PCB File - Copy the pattern from all the Components in an external 
design file. Once you have placed and routed a common block of 
Components, you can use copy and paste to place a copy of this pattern 
into a separate design. These layout pattern designs can then be saved in 
the a directory to form a library of common layout patterns. 
Use the dropdown list to select a pattern file from the directory shown, 
or use the Browse button to change the folder.  

Apply Pattern To 

Choose which set of Components you wish to apply the layout pattern to.  

 All Components - Apply the pattern to all Components in the design. 
Use this when you are creating a PCB design that is very similar to an 
already completed design.  
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 Selected Components - Apply the pattern to the selected placed 
Components in the design.  

 All Components In Bin - Apply the changes to the Components in the 
bin.  

 Selected Components In Bin - Apply the changes to the Components 
in the bin that have been selected. This is only available if more than 
one Component has been selected in the bin list.  

 Group - Apply the pattern to the Components in the chosen group.  

Apply Pattern 

Once the pattern has been established, the Apply Pattern button is used to apply 
the layout pattern from one set of Components to the other. The method will 
attempt to match as many Components as possible between the two sets using 
part names, pin counts, similar nets etc. Any Components not matched will be 
left in their previous position.  

Any tracks between the Components that are having the pattern applied will be 
removed prior to the operation. Tracks from these Components to other 
Components not involved will be unrouted, ready to be re-routed by hand after 
the pattern has been applied.  

Each Component will be moved to the location of its matched Component in the 
layout pattern. The repositioned Components and their new track paths will be 
left selected after the operation. This makes it easy to use the move option to 
position them.  

If you do not like the result, use Undo to revert back to the previous placement 
and routing pattern.  

Fatten/Neck Tracks 
There is a new option on the Tools menu and the shortcut menu and is used to 
fatten (neck) tracks. Where possible, this will work from the default track width 
to the alternative track width, and neck tracks if needed to avoid errors. The 
option swaps the track back to minimum width and then fattens where it can and 
remain legal. 

 
Two options provided on the Tools menu are Fatten/Neck All Tracks and 
Fatten/Neck Selection. The latter only acts on the selected track segments and is 
also available from the shortcut menu when a track segment is selected. 
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The track must have a net class defined for it as well as Values for the Default 
and Alternative track widths. These values are edited in the Net Class option on 
the Technology dialog. 

 
The Fatten and Neck track options will work but looking at the thickness of the 
Track Style used in the Net Class for that net, and then comparing with the 
‘other’ style. If it is thicker, then it fattens up to it. It is normal to be initially 
using the Def. Track style and to fatten up to the Alt. Track style but either way 
will work. 

To avoid the option adding really short segments of track length, there is a 
minimum necked or fattened track length field to add a value to. The default 
value <Default> is set to 4 times the 'fat' track width, but you can enter an 
absolute value for this on a Net Class. 

RF Design - Spirals 
As part of the increasing support for RF designers, you can now use Pulsonix to 
insert a copper or track spirals (and breakouts in footprints). 

Insert Spiral is a new option available on the Insert menu. This feature can be 
used for designing spiral inductors and planar transformers. 

 
When adding the spiral, various parameters allow you to control its shape.  
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Select the Net to connect the spiral to. For tracks you must select an existing net, 
but Copper does not have to be on a net.  

The Layer box is used to select the layer to place the spiral on.  

Style is used to select the track/copper Style of the spiral. You can also type a 
Width.  

The Spiral Dimensions 

 
The spiral always begins at the inner right side and ends at the outer right side 
(but you can rotate or mirror it later).  

The Gap is the distance between each turn of the spiral excluding the segments 
Widths.  

The Num of Turns is the number of complete loops of the spiral.  

The Inner Width is the distance across the inner void of the spiral.  

The Aspect Ratio allows you to create rectangular spirals and is the ratio of 
Height / Width. So an Aspect Ratio > 1.0 gives a tall spiral, and < 1.0 gives a 
Wide spiral.  

The Corner Radius is the initial inner radius of the corners of the spiral.  

Concentric Corners gives you tight corners which are properly nested, 
increasing in radius as the number of turns increases. Otherwise the corners are 
fixed at the Corner Radius.  

The Circular option fixes Concentric Corners on, and the Corner Radius to 
be half the Width plus the Inner Width. This has the effect of giving near 
circular spirals. A zero Corner Radius and not Concentric Corners will give 
you square corners.  
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Note: Spirals are added normal track and copper, to modify, you should use 
delete and then add another one. 

Auto Router Changes 

Use of DO Files 

For users who have the autorouter option, you can now use any existing DO files 
with the new autorouter. DO files are ASCII command files that can be used to 
drive the autorouter. These files originate and follow the Specctra auto router 
format. This file contains a list of route, cost and rule commands which defines 
the strategy to use.  

 
The command file is selected by either typing the name of the file or using the 
File Browser to locate the file. A list of available commands and their syntax 
can be found in the Pulsonix online help pages. 

Auto Route Selected Nets 

When using the Auto Route> Browse Nets and Route Selected options, you 
can now specify whether the Router Parameters dialog is displayed (and acted 
on). This option is available from the Options dialog under Interaction. 
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Auto Place Changes 
The Autoplace option has been enhanced. 

 You can now choose to place Components in a named group. 

 You can now place to any selected or named area in the design. 

 You can now place Components around any, selected or named board 
outline or named area in the design. 

 You can now place around the board outline using this dialog. 

This section of the dialog allows you to choose which Components are to be 
considered for placement, and where you want them to go. These buttons can be 
used in various combinations, enabling you to carry out complex placement 
operations in 'stages' to produce the desired results. 
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Place Around Board From Bin 
If any Components are selected in the bin, the Place Around Board option 
available on the shortcut menu will only place the selected Components around 
the board. If nothing is selected it will place all the Components in the bin. 

 

Options dialog change in Version 4.0 Build 2569 
A new switch, Check Poured Copper in the Options dialog on the Online 
DRC page has been added to allow you to force online DRC checking to ignore 
poured copper. 

 
Use this when adding tracks that will be routed into a poured copper shape. This 
will stop the continuous track to copper errors being displayed. Re-pour the 
copper after the track has been added to clear the copper around the track. 
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Chapter 5. New Cost Options 

High Speed Option 

Interactive Differential Pair Routing 

To aid the design of high speed circuits, you can define Differential Pair Rules 
in the design (at both Schematic and PCB stages). The interactive Differential 
Pair Routing feature is available in the PCB design editor. 

 
A Differential Pair consists of two pairs of pins on two different nets which 
should be routed together as close as possible. It is possible to define such pairs 
in the Technology dialog under Differential Pairs. The pair may have rules 
associated with them which define how close the tracks should be and how much 
they are allowed to differ in length. Once this is defined, a special manual 
routing mode can be used to route the two track paths together. Paired track 
sections are locked together using the spacing rules gap. Whilst paired, 
subsequent editing of the tracks will keep them locked together using the 
functionality provided. 

Differential Pair Rules 

The spacing and length rules are defined in the Technology dialog. The spacing 
is either defined explicitly, or is taken from the Spacing Rule appropriate to the 
two nets. Length rules, if defined, can be checked as part of the Design Rule 
Checking. 
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If the two potential differential pair nets are selected when the Technology dialog 
is opened, these net names will be entered directly as pre-selected in the 
Differential Pairs dialog when the New (Pairs) button is used. 

 
For each pair you provide: 

 The net and pair of pins for the first master pin pair 

 The net and pair of pins for the second pin pair 

 The minimum gap allowed between the tracks 

 The minimum percentage of how much the tracks are paired  

 The maximum allowed track length difference between the pairs 

Defining a Differential Pair 

A Differential Pair is defined in the Technology dialog under Differential Pairs. 

A Differential Pair requires two pairs of pins on two different nets. In this dialog 
you can define these two pin pairs by firstly selecting a net. This will 
automatically select the first two pins in this net. It will normally be the case that 
the net only has two pins, otherwise you should ensure that the correct two pins 
are selected. Repeat this for the second pin pair.  

 
You can optionally define rules for this pair.  
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The Minimum Gap is the minimum distance the pair of tracks can be. This can 
be less than the normal spacing rules for these nets (which would otherwise be 
the value used).  

The Minimum % Paired is a rule which is checked by the design rules checker 
(under Nets, Differential Pairs). It ensures that of the total length of the two 
Paired tracks, the minimum % value defined for the proximity with each other is 
obeyed. If 80% is defined, then 80% of the track length must be within the 
minimum spacking rule. 

The Maximum Length Difference is the maximum the two track paths are 
allowed to differ in length.  

Routing a Differential Pair 

This is the process of routing a differential pair track pair: 

 To route a differential pair  

1. Begin by routing from one of the pins in the set (double click on the net), 
this will be the Master net. Normally you would create a small stub to 
start the route then enable the differential pair mode. 

 
2. From the shortcut menu, use the Start Differential Pairing mode 

 
3. You will see that a clone track appears parallel to the track you are 

routing. This is the track on the opposite paired net and will be spaced 
using the spacing rule defined or the Min. Gap rule. 
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4. Each track pair has a master track and a clone. Only the master track can 
be modified directly, the clone is simply updated to match the master. 

5. Continue routing in the normal way adding corners as required. The 
clone will follow the master track in shape. 

 
6. On the shortcut menu use the End Differential Pairing command to 

stop the pairing (the Complete Track command also ends the pairing).  

 
7. Finish the track by editing the remaining connection in the usual way. 
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8. Complete the pair by routing the connections at the end of the ‘cone’ 

track. 

9. This paired tracking is now ‘locked’ together until impaired. 

Remove Differential Pair Routing 

A paired section of track (or a selected part of it) can be unpaired using the 
shortcut menu command Remove Differential Pairing whilst in select mode.  

You can create any number of paired sections of track along the path but you 
must complete the gaps manually.  

Add Differential Pair Routing 

An additional option is also available for the addition of differential pair routing 
– Add Differential Pair Routing. 

The process of using this is to route the first paired net, then to select it and from 
the shortcut menu select Add Differential Pair Routing. An exact copy of the 
first track will appear parallel to it using the spacing rules distance or rules 
distance defined. As before you would now edit each of the remaining 
connections to complete the routing on the clone. 

Differential Pair Routing Colours 

You can draw the master and clone pairs in different colours (using two entries 
in the Colours dialog and Highlights page). 
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DRC Dialog 

The DRC dialog can be used to check Differential Pairs using rules defined in 
the Technology, this is available as a Nets check. 

 
The checker will report an error if: 

 The percentage of paired track length to the total track length is less 
than the minimum defined in the technology. 

 The maximum total track length of the pairs is less than the max defined 
in the Technology. 

 The tracks keep the specified distance apart.  

A sample DRC error report might look like this: 
Differential Pair Length Difference (DPL) at (3400.0 
3375.0) on Layer "Top Electrical". 
Differential Pair Paired Length (DPP) at (3400.0 
3375.0) on Layer "Top Electrical". 
Total: 
     1 Differential Pair Length Difference (DPL) 
     1 Differential Pair Paired Length (DPP) 
Number of errors found : 2 
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Interactive Net Length Indicators 

A new interactive High Speed feature has been added to Pulsonix. This allows 
you to define length rules (in both the Schematic and PCB Designs. If defined in 
the Schematic, these rules are translated into the PCB) and then for the 
interactive track editing facility to display the rules as restriction boundaries. 

If there is a Track Length rule on the Net Class for the track being added or 
edited, or if the track is part of a pin network, then a shape is drawn indicating 
how far the track can be extended and still be within the total net (or pin 
network) rule. This is defined on the Net Class dialog under the Rules tab and 
Track Length Min: and Max: 

 
Separate shapes are drawn to indicate minimum and maximum net length rules.  

  
The large oval area shows the length 
of the track is within the minimum 
track length set. 

The small oval area shows that 
the maximum length rule has 
been exceeded. 

The colours for the Legal and Illegal track lengths can be defined in the Options 
dialog under Edit Track. 
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Track Length Limits 

As well as the visual indicators for Legal and Illegal values, the rule values used 
can also be displayed. Using the Show Limit Text check box, the text value can 
be displayed. Again, this is defined in the Options dialog under the Edit Track 
tab. 

  

The Text Screen Height box allows you to define a text height that will be 
suitable when viewed. This value is the real screen height and is not related to 
the design text sizes. 

Serpentine Routing 

Another new High Speed feature for balancing the length of high speed nets is 
the insertion of track ‘length’ without introducing spacing errors. This is 
commonly known as Serpentine Routing.  

 
You can select a track segment (or segments) and run the Serpentine Routing 
command from the shortcut menu which prompts for the serpentine parameters. 
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Parameters are defined for the amplitude and separation of each loop. You can 
also define the minimum number of loop cycles to insert, and also the amount of 
additional length required (otherwise it will do as much as possible). 

 
You can define two amplitudes that it can use to automatically reduce the 
amplitude to avoid obstacles, shown below. 

 
The serpentine parameters can be defined in the Net Class dialog, these values 
are used to prime the dialog. Net Class net and connection rules will be applied 
to prime the dialog with the required amount of additional track. 

 
If Additional Length is required this can also be defined. If enabled, the 
serpentine routing option will stop once this length has been exceeded, otherwise 
the whole of the selected segments will be considered for serpentine routing. If a 
track minimum length rule has been defined on the Net Class, then the dialog 
will be primed with the Additional Length required to satisfy this rule. 
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From the shortcut menu, for a selected track the Remove Serpentine feature can 
be used to remove a selected section of serpentine routing. It can also be used to 
remove all serpentine routing from the design.  

Also on the shortcut menu is the Reduce Serpentine Routing feature to reduce a 
selected section of serpentine routing by one 'loop'. This enables it to be easily 
trimmed to the correct length without interactively editing the track. 

Embedded Component Technology 

Technology Overview 

New functionality has been added to Pulsonix to support the addition of 
embedded Components such as printed resistors, etched resistors, embedded 
capacitors and RF Components. 

Some manufacturing technologies allow you to place and embed Components in 
the layer stack within the board. This technology allows much more efficient use 
of space, but requires additional features in the CAD system to enable this.  

In a conventional PCB design, Components can only be added to the Top or 
Bottom sides of the board. A conventional footprint will have a body which is 
placed above the surface of the board and pads which fit onto or through the 
board. You would normally have the following items in a footprint definition: a 
silkscreen outline which is associated with the top side (mirrored to the bottom 
when the Component is placed on the bottom); a placement area which 
represents the space needed to accommodate the body of the Component and is 
either through the board, or just on the top (and mirrored when on the bottom); 
pads (though-hole or surface mount); resist shapes, which are often generated 
from the oversized pad shapes.  

In a conventional technology, you would define Silkscreen, Resist and 
Placement non-electrical layers which are associated with the Top and Bottom 
electrical layers.  

Embedded Components may not have a body like conventional Components, the 
functionality of the Component is built into the board, using copper shapes and 
perhaps resistive or capacitive materials which are applied to the board during 
manufacture. There are many different types of embedded Component, but they 
all have common requirements to enable them to be added to a design.  

With embedded Components you may want to place pads and copper shapes on 
inner layers and create resist or coating shapes on layers which are embedded in 
the board stack. When you change the layer of such a Component, you would 
want all the associated shapes to follow the pads.  

In a similar way to the conventional technology, you can create additional non-
electrical layers which are associated with an inner electrical layer. You can also 
define an inner layer to be one which embedded Components are allowed to be 
placed on. For embedded Components to work correctly it is essential to define 
the design technology correctly before you begin to define the footprints.  
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If you are using embedded Components, it is likely that you may also want to 
use blind or buried vias which are only partly drilled through the board. You can 
do this by defining layer spans which define the spans which can be drilled.  

 

Printed Resistors 

A printed resistor consists of two pads, connected by resistive material. 
Depending on the manufacturing method, a resist mask or encapsulating coating 
may also be required. The technology would therefore 
require an electrical layer with associated non-electrical 
layers for the resistive material, resist and coating 
shapes. If you wanted to place these embedded resistors 
on electrical inner layer 1 you would first define this 
layer as one which Can Have Associated Layers and 
as one which can Allow Components. Then create the 
appropriate non-electrical layers, and Associate them 
with the inner layer. It would be appropriate to define 
the layer class for these non-electrical layers as 
Essential For Manufacture, this would prevent the 
Component from being added to electrical layers which 
do not have these associated layers present. Using this 
technology, a footprint can be created with the 
appropriate shapes. This footprint should be marked as 
an Embedded Component (on Save To Library), this tells the system that it is 
a footprint which can be placed on inner layers. If more than one set of 
appropriately defined layers exist, Change Layer can be used to move the 
footprint through the layer stack.  
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Planar Converter 

A second example of an embedded Component shows a planar converter.  

 
This Component exists on the outer layers and may have a physical body applied 
to the outer layers. However, part of the footprint consists of copper spirals 
which are connected by a Component Via, effectively joining the two footprint 
pads. Although the pads are joined we would want to connect them to different 
nets. We can do this because it is possible to mark the copper spirals and 
Component Via as not checked (using Properties in the footprint’s Component 
Via entry).  

A Component Via is a fixed part of a footprint, but unlike a pad or mounting 
hole, it does not have a pin number and it exists on a layer span, like a normal 
routing via. If we defined this footprint but did not mark it as embedded, 
mirroring the Component would not swap the inner electrical layers. By defining 
the footprint as embedded, you can mirror the Component and all the inner 
layers will swap as expected.  

Overview of Process 

To use embedded Components you must follow this process: 

 Edit or create the Technology file that you wish to use. This will be 
used for the design and to create the footprint. 

 Add Layers and Layer Classes to support embedded component 
technology. For layers that are critical to the final manufacturing 
process, select the Essential For Manufacturing check box in Layers 
Classes. 

 Add Inner Electrical layers and allow Associated Layers. Also enable 
the electrical layer to Allow Components (embedded Components). 

 Add Inner non-electrical layers to support the embedded component 
manufacturing process. 

 Create the footprint and save it using the Embedded Component check 
box on the Save to Library dialog. 
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Application of new functionality 

To enable this new functionality, Pulsonix V4.0 has been modified in particular 
areas: 

Layers dialog 

Changes have been made to the Layers dialog grid to support the addition of 
inner layer ‘sets’. Pulsonix already has <Top Side> and <Bottom Side> layer 
sets, and you can now add <Inner> layer sets. 

 
The Layer Names column has been split into two columns - Name and 
Associated Layer. The second column is used to hold names of layers that are 
‘associated’ with a layer set. So for example, a Top layer might have associated 
with it, Top Silkscreen, Top Paste, Top Wire etc. 

Dark horizontal lines have been added to split the rows into groups of layers 
associated with the same layer set. 

 
The Side column is now read only and does not allow changes to be edited 
directly in it. Instead you should using the Edit button and dialog. 

Cells which are considered to be not relevant or read-only are greyed out. 

Within the dialog, changing order of rows is restricted to reduce chance of 
invalid situations. 

The number of electrical layers are shown at the bottom of the page. 



102   Pulsonix V4.0 Update 

 
The Edit Layer dialog has been changed, it now supports associated layers. 
Restrictions are now imposed to what you can change based on layer type. 

 
You can now set up an inner electrical layer to have associated non-electrical 
layers (using Associated With:). Non-electrical layers can be put on an inner 
layer. The inner layer set is the name of the inner electrical layer in angled 
brackets e.g. <inner 4>. 

You can mark which layer sets you can place Components on by using a check 
box on the electrical layer – Allow Components. You can also mark whether the 
Component must be mirrored on that layer set. 

 
The ability has been added so you can select Add Material and Add Layer 
Classes directly from the edit layer dialog.  

The Layer Class dialog has been changed for easier use. An Essential For 
Manufacture checkbox has been added for non-elect layer classes. Checking 
this box means that any items in the footprint on a layer using this class are 
essential for the manufacture of the Component. You will not be able to add this 
Component to a design that does not have the appropriate layers. 



 Pulsonix V4.0 Update   103 

 
This is needed as you should not be able to add a embedded resistor that has its 
resistive material etch outline defined, on any layer in the design that does not 
also have an associated layer for the etch outline to live on. 

The Embedding drop-down allows you to specify the direction of any embedded 
layers with the layer directly above or below it. This is used as reference for 
manufacturers and is not directly used in Pulsonix. 

 

Footprints for Embedded Components 

Embedded footprints can be defined in the footprint editor with pads and shapes 
etc. on inner layers. Footprints can be marked as Embedded Component when 
using the Symbol name dialog or when adding it to the library.  

 

Insert Component 

When adding a embedded Component to a design, it will try to place the device 
on the top most layer used in the footprint. An embedded Component in a PCB 
design will show its layer on the status bar.  If the layers it was defined on don't 
exist in the design, it will be placed on the top most layer set that contains all the 
essential layers used in it.  

Using Change Layer 

You can select an embedded Component and use the Change Layer option to 
set its layer in the design. Mirror will not be available as a mirror is 
automatically performed when changing layers to a layer that is marked to 
Mirror Components.  
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You cannot change an embedded Component to a layer set that does not have an 
associated essential layer to place its critical items on. Copper and Pads are 
assumed to be essential. 

Component Vias 

You can now add Component Vias to footprints. These can be added to any 
footprint, not just embedded Components.  These can have the flag No spacing 
check within footprint set so that they can join two pads (for a embedded 
resistor via for example). 

 

Properties dialog 

Properties of an embedded Component shows if a Component is embedded and 
allows you to edit its Layer instead of its mirror flag. You cannot edit mixed 
embedded and normal Components using a multiple selection, you would have 
to edit these individually. 

Layers Report 

The Layers Report will report a reference layer for the inner layer side if there 
is one. It also reports if a layer class is essential for manufacture.  

Report Maker 

New fields have been added to the Report Maker to support embedded 
Components. See above in the General Options sections and Report Maker for 
more details. 
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Chapter 6. Spice Simulator Changes 

Spice Update 
For users who have the Pulsonix Spice A/D mixed mode simulator option, there 
have been a number of significant changes. 

Spice Engine Update 

Speed Increase 

The Spice ‘engine’ itself has been updated to be significantly faster (between 50-
150% simulation speed improvement depending on the circuit) and more 
accurate with convergence improvements. 

CircuitSim90 Benchmark Netlists 

Of the industry standard CircuitSim90 benchmark netlists (57 in all), Pulsonix 
Spice now runs all 57 to the point at which they converge and produce an 
accurate result. 

Simulation Menu Changes 
The simulation menu has been modified and updated to accommodate new 
functionality and to improve the usage of existing functionality. 

 
Version 3.1 Simulation menu 

 
Version 4.0 Simulation menu 
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Monte Carlo Menu 

The Monte Carlo> Run option has been removed. To support this there is an 
interface change, it is now just one of 6 sweep and step modes. This option is 
also much faster. (for .OP it can be up to 100 times faster!!). 

The new Plot Histogram option now uses the Performance Analysis dialog in 
the simulator. 

 

Monte Carlo Analysis 

Tolerance Implementation has changed. Tolerances are now specified using 
expressions containing a distribution function. The old methods is still valid and 
can be used. This now an extension of the analysis line in netlist. 

Step Parameter  

Step Parameter has been removed from the Schematic Simulation menu and is 
now done using multi-step analysis. 

Bias Annotation  

On the Bias Annotation> menu, the Insert Bias Current Marker has been 
added to annotate the schematic with the results of a DC Operating Point 
analysis. This displays the current on the pin, that the markers are attached to. 
The values shown on the markers are updated each time you simulate. This has 
also been added to the Spice toolbar and Misc. component bar. To support this, a 
new Bias Current Marker Part and symbol has been created. 
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Run Asynchronous 

There is a new option to run simulation in background – Run Asynchronous. 
Resulting data can be read into simulator in the future to analyse results. 

Restart Transient 

New Restart Transient option is used to continue transient simulation to run to 
a later stop time. 

New Simulator Sub-menu Commands 

The Simulator sub-menu has been changed to now allow the control of the 
simulator from within Pulsonix. Commands have been added to Abort, Pause 
and Resume the simulator. 

 

New Fixed Probes 

There are a number of new fixed probes available on the Fixed Probe sub-menu: 

 Inline Current Probe. 

 Keep Inline Current. 

 Bus Probe 

 Bode Plot Probe 

Also, the Keep Voltage and Keep Current probes have been moved into the 
Fixed Probe sub-menu. 

New Specific Source Devices 

Each source type pair (Voltage and Current) now has its own dialog. The old 
Sources is renamed to Universal. 

 AC Voltage Source & AC Current Source 

 DC Voltage Source & DC Current Source 

 PWL Voltage Source & PWL Current Source 
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 Voltage Waveform Generator & Current Waveform Generator 

A new menu item, Insert Source has been added to the Simulation menu. 

Random Probe Changes 

Probe Arbitrary Expression has been renamed to Add Curve... 

New Random Probes have been added for Bus Probe and Performance 
Analysis. 

The Fourier Probe has been added - Probe Voltage (Quick Fourier), Probe 
Voltage (Custom Fourier) and Add Fourier Plot. 

Simulation Parameter Dialog Changes 
Monte Carlo and Multi-Step Analysis has been added to all modes on the 
Simulation dialog. 

 
Sweep Modes have been added to AC, DC, Noise and TF modes. This is 
enabled through the Define Multi-Step button once the Enable Multi-Step 
check box has been selected. 
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On the Transient Analysis dialog, Min Time Step and Fast Start are available 
using the Advanced Options button. 

 
On the AC page, Save All Currents has been added to Data Output. 

 
On the DC page, Decade Vs Linear Sweep method has been added. 
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On the Options dialog - Initial Condition Force 

 
Under Circuit Conditions, List File Output a check box to Expand Sub-
circuits has been added along with the Parameters output. 

 
 Under Monte Carlo, you can now select Set Seed using the check box. 

 
 A new mode is available TF - Transfer Function. 
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New Analysis Sweep Modes 

.AC and .NOISE analysis can now sweep more than just frequency. 

Transfer Function analysis. Calculates the gain from every source on the 
circuit to a nominated output.    

Monte Carlo is now a sweep mode. 

Second level application to provide stepped analysis. 

Interactive parameter stepping is replaced by Multi Step Analysis. 

Other Interface Changes 

Select Model dialog 

Using the Select Model dialog (from the F7 Component selection), you can 
preview the model details, (to run this option you need the simulator running). 

 

Add Part Using Model 

Now has ability to preview either Model or Part details (needs simulator 
running). 
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Potentiometer changes 

When adding or editing (using F7) Potentiometer Vales, you are presented with a 
dialog to set the wiper step value and switch to run the simulator if the wiper 
position changes. 

 
A new command has been added for Increment Spice Value and Decrement 
Spice Value used on passive devices and potentiometer. Shortcut key commands 
have been added using Shift-PageUp and Shift-PageDown 
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New/Changed Toolbar Popups 

There are new toolbar popups named Magnetics and Analog Behavioural. The 
Functions toolbar popup is now named Digital Generic. 

Part Editor Changes 
The Part editor has been changed to support the new devices (listed over). This is 
available on the Edit Spice Type dialog and Edit Template. 

 

 
New template driven device keywords have been added to support new models: 

<param["parameter name"]> 
This extracts the value of the named parameter from the SpiceParameters or 
SpiceValue attributes. 

<if["parameter name"]> ..... <else> ..... <endif> 
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This extracts the parameter value like above and if it is defined and not "0" or 
"false" then it writes out the template commands before the <endif> keyword. If 
not defined, it writes the template commands between <else> and <endif>. Note: 
the <else> is optional and you cannot nest if commands. 

<repeat[limit]> .....  <endrepeat> 
This repeats the template commands between the keywords as many times as 
specified by the "limit". Limit is a parameter name to retrieve the number from 
or a direct integer. You must not nest repeat commands. 

<count> 
This is used in a repeat loop to output the current loop count (starting from 1). 

<add[arg1][arg2]>  
arg1 and arg2 are any number, or a parameter name to get the value from, or 
<count>.  Adds two numbers and writes result to netlist. 

Can also use 'sub', 'mul' and 'div'. If both numbers are integers, then  the result is 
an integer apart from 'div'. 

Arbitrary Source Improvements within Expressions 
A conditional function IF() has now been added. 

You can now put circuit variables (i.e. references to voltages and currents using 
V() and I()) into parameter expressions that are used in arbitrary source 
expressions. So you can do something like ".PARAM Vmult = { V(a)*V(b) }" 
then use Vmult in the defining expression for an arbitrary source. 

DDT and SDT functions for differentiation and integration respectively. 
 These work in AC analysis as well as transient. 

Arbitrary source optimisation algorithm. Analyses arbitrary source expressions 
for common sub-expressions and factors. By default this is enabled only for 
expressions that use 

.FUNC definitions. Can be switched on globally with an option setting. This 
feature improves the running speed of the Infineon power models, sometimes 
dramatically so. Compatible with the PSpice equivalent. 

 Floor function is supported. When used this returns an argument truncated to the 
next lowest integer. 

.PARAM Command 

The PARAM command can now be used in library models and sub-circuits. It 
defines a simulation variable for use in an expression. Expressions may be 
used to define device parameters, to define model parameters, for arbitrary 
sources and to define variables themselves. 
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Support of .FUNC Function 

Pulsonix Spice now supports the .FUNC function. .FUNC defines a function that 
can be used in a model or device parameter expression, a parameter defined 
using .PARAM or in an arbitrary source expression. 

Improved .KEEP 

Includes wildcards, making it possible to specify all the voltages or currents from 
a specified sub-circuit to be saved. Text filters using wildcard characters '*' and 
'?' may now be used with .KEEP 

Changed/Updated Devices 

Changed Devices 

Capacitor    New dialog with IC voltage section.   
    New params: DTEMP M 

Ideal Inductor    New dialog with IC current section.   
    New Params: M 

Resistor   New Params: ACRES DTEMP L M SCALE W 

Diode & JFET  New Params: DTEMP M 

Mosfet   New Params: DTEMP 

New Devices 

Ideal DC Transformer New device like Ideal Transformer, but non inductive 
so simpler dialog. 

 Infinite Capacitor 

New Parameterised Devices 

This presents you with the Edit Device Parameters dialog to edit the 
parameters. 

Lossy Inductor 

Transmission Line (Lossless) 

Electrolytic Cap (Level 1-3)  

Electrolytic Cap (Level 4-5)  

Electrolytic Cap (ladder model)  

Transmission Line (Lossy RLC) 
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Parameterised Opamp 

Switch With Hysteresis 

Peak To Peak Voltage Source 

 New "Saturable Transformer / Inductor" device 

This replaces the Saturable Inductor, Saturable Transformer and Saturable 
Transformer 2 secs devices. 

One dialog now maps to different symbols depending on the number of 
primaries and secondaries have been defined. 

Simulator Changes 
 Support for HSPICE devices, support includes - Netlist Compatibility, 

Model Compatibility and Process Binning. 

 parameters for level 3 Diode 

 .PARAM library support  

 Junction GMIN DCOP Convergence Method  

 Netlist pre-processor provides conditional devices using .IF and 
repetition using .WHILE.  

 Digital Simulator: Two new parameters for digital devices that define 
output resistance for positive and negative slopes.  

 Digital Simulator: Wire Delay. An additional capacitance can be added 
to each output related to the number of inputs that it drives 

 Subcircuit currents are now saved as actual data rather than aliases 
when it is efficient to do so. This reduces the size of the data file and 
improves plotting speed in situations where only top level data is stored. 

 The 'M' multiplier as an instance parameter has been added to more 
devices including capacitors, diodes and JFETs. 

New Resistor Parameters  

 ACRES – different value for AC than DC 

 Flicker Noise parameters are supported as part of Noise vectors. 

AC Currents 

Current in AC analysis is now available for virtually all devices including BJTs, 
JFETs, MOSFETs, diodes and all SPICE passive devices. Note however that AC 
current has to be explicitly enabled for semiconductor devices. This is because 
outputting current data is expensive in simulation time. 
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Simulator Devices 

Lateral PNP. Use device name of LPNP. The lateral pnp connects the substrate 
capacitance to the base. Also, the substrate diode DC characteristics are now 
implemented. (ISS non-zero)  

PSpice JFET parameters. All the PSpice JFET parameters are now implemented.  

HSPICE level 3 diode implemented. This has a number of additional parameters 
notably for sidewall capacitance.  

Full support for Infineon power device models, by virtue of the addition of 
.FUNC and the DDT function. Also arbitrary source optimisation algorithm 
improves running speed of these models, in some cases dramatically so.  

Drag n Drop models 

You can now drag models or library folders onto the Command Shell window 
to add new libraries to Pulsonix Spice. 

 
Dropping the folder from the Windows Explorer dialog onto the Command 
Shell window displays the Select Library dialog. 
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Much better Graph dialog editing 

Below is a summary of the new features found within the new simulator 
interface: 

All dialogs used can now be resized 

Windows XP themes are now supported when running Windows XP 

The command shell now has a small toolbar 

Toolbars and graph legend panel are dockable. That is they can be moved to new 
locations or undocked completely from their parent window.  

Graph Annotation 

There is now a range of annotation objects that can be placed and freely moved 
on a graph in order to annotate it for documentation purposes. These include a 
curve marker, free text, boxed text and captions. You can also add legend into 
the graph for printing. 

Cursor Enhancements 

The measurement cursors are now cross hairs instead of the small cross used 
before. (The older style is still available if preferred). The cursor position and 
separation display is now displayed on the graph itself as an arrowed dimension. 
(The older method is still available and may be preferred on slow machines) The 
method of moving cursors has been improved. Previously you could only move 
the cursor along the horizontal axis while the cursor tracked its curve. This made 
it hard to position the cursor on a vertical edge. Now you can move the cursor 
along the vertical axis or alternatively you can pick it up and place it where you 
want it including on another curve. When released it will snap to the nearest 
point on the nearest curve.  

New features in the Graph Windows 

Graph windows now have fixed menus at top of program. 

Graph windows will now scroll vertically to accommodate more grids and digital 
axes.  

Update Curves Feature 

This instructs Pulsonix Spice to re-plot the curves in a graph sheet using the 
latest simulation data. An option to add rather than replace the new curves is 
provided.  
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Define Curve Improvements 

A Wildcard Filter is now available for vectors selection. In the Define Curve 
dialog box, a new method of filtering the available vectors has been added. This 
uses a wildcard specification that is related only to the full name of the vector. 
That is, it doesn’t care whether it is a voltage, current or digital signal.  

The history drop down box for expressions in the Add Curve dialog is now 
saved between sessions.  

It is now possible to highlight curves within graphs. 

Fixed Probe Improvements (.GRAPH) 

This can now efficiently incrementally plot expressions that satisfy certain 
conditions. This was possible in the earlier release but was inefficient.  

Copy and Paste 

Its now possible to move or copy a curve to a new graph sheet using a copy and 
paste curve feature.  

Tabulated ASCII data, for example from a spreadsheet, may be pasted directly 
into the waveform viewer.  

Axes 

You can now switch between log and linear axes after the graph has been 
created.  

You can now adjust the height of digital axes. See the File menu and Options, 
General... select Graph, Probe, Data Analysis Grids and digital axes may now 
each be reordered arbitrarily.  

The zoom to fit y-axis feature now operates on only the displayed portion of the 
x-axis instead of the whole x-axis as before. So, for example, if you wish to view 
a small oscillation at the top of a pulse, you can adjust the x-axis limits 
appropriately then zoom to fit y-axis to achieve optimum magnification.  

You can now re-order grids in the Y direction (separate digital and analogue). 

Saving 

You can now save a graph to a binary file and recover it later. Everything is 
saved including cursor positions, annotations and all the data for each curve.  

There is also a facility to save the graph to a windows metafile for importing to 
other applications, such as Microsoft Word. 

Simulation data may be exported in SPICE3 raw format. This is useful for 
interfacing to other applications including third party waveform viewers. 
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You can now read in SPICE3 raw files for importing data from other simulation 
tools. The data is written out to a .SXDAT file in an efficient format. This allows 
the handling of very large files. Many simulators can output data in this format.  

Define Fourier plot 

A Fourier spectrum of a signal can be obtained in a number of ways. You have a 
choice of using the default settings for the calculation of the Fourier spectrum or 
you can customise the settings for each plot. The following menus use the 
default settings: 

Graph menu and Measure Plot Fourier of Curve 

Graph menu and Measure Plot Fourier of Curve (Cursor span) 

The Define Fourier option on the Graphs and Data menu displays the 
following dialog: 

 
You will see a dialog similar to that shown for Plotting arbitrary expressions 
will be displayed but will include a Fourier tab. Click on the this tab to display 
the Fourier analysis options. 

Fourier Analysis 

A wide range of options are now available for Fourier analysis including:  

 Specify time range to apply transform  

 Specify fundamental frequency so that an exact number of cycles is 
used for calculation  

 More windows 

 Specify start and finish frequencies  

 Specify log x-axis  

 option to plot phase instead of magnitude  
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In addition there is now an alternative algorithm to the FFT. This is Continuous 
Fourier. This method is much slower but has the advantage of not suffering 
from aliasing and therefore is a better method when applied to signals with high 
frequency content such as narrow pulses.  

New Models 
New models have been added to the Pulsonix Spice product libraries. 

 390 new MOSFETs, Diodes and IGBTs have been added to the IR 
library 

 85 new Opamps have been added to the LTC library 

 140 new Transistors and MOSFETs have been added to the old Zetex 
library to make new Zmodel libraries. 

New Spice libraries have been added for the following: 

 New Infineon library containing 450+ Discrete MOSFET models 

 Magnetic Core libraries containing 50+ models 

New Components/Symbols have been added to support the new models supplied. 
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New Features for Version 4.0 Build 2569 Issued Sept 2006 

Safe Operating Area (SOA) Testing 

Overview 

Safe Operating Area (SOA) testing is a feature that can be used with DC or 
Transient analyses. With SOA testing, you can set maximum and minimum 
limits for any simulation quantity and the simulator will display when those 
limits are violated. It is intended to check that semiconductor devices are 
operating within the manufacturer's design limits.  

Defining SOA in Pulsonix 

To use SOA testing, you must do two things: 

1. Define the SOA limits for the models or devices you are using. 

2. Enable and configure SOA testing. 

Item 1. above is covered below in the section on .SETSOA and also the LIMIT 
parameter described under .MODEL. 

Item 2. above is covered in the .OPTIONS section below.: 

Both of these commands can be placed in the netlist by using the Extra 
Simulation Data option in Pulsonix. 

Defining Simple Limit Tests 

In the next release we will include fixed probes to perform some simple limit 
tests, but for now you can use the .SETSOA commands to define these tests to 
report the following: 

1. Over and under voltage on a single net 

2. Over and under current on a single device pin 

3. Over and under differential voltage on a net pair 

This can be done using: 

.SETSOA Label=“your label” expression=(minimum limit, maximum limit) 

Where expression is “net name”, “pin name” , or “net1 name – net 2 name” for 
the reports mentioned above. 

For example: 

.SETSOA Label=Watch1 “Q1_C” =(-1, 1) 
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Each of these commands has three parameters that specify: 

1. The minimum limit. Use a large negative number (e.g. -1e100) if you don’t 
wish to specify a minimum limit. 

2. The maximum limit. Use a large positive number (e.g. 1e100) if you don’t 
wish to specify a maximum limit. 

3. A label. 

Setting up SOA Testing  

To enable SOA testing, you need to add a .OPTIONS line to your Extra 
Simulation Data as follows: 

.OPTIONS SOAMODE=<Mode> SOAOUTPUT=<Output> 

Where <Mode> is “Summary” or “Full”. In Summary: output mode, only the 
first violation for each SOA device will be reported. In Full output mode, all 
violations are reported. 

For <Output>, choose where you would like the results reported. Use “msg” to 
report to the Command Shell message window, or “list” to add results to the list 
file. Note that writing results to the message window is a time consuming 
operation and it is recommended that you should not select this if you are 
expecting a large number of violations. 

Running Simulation 

Run the Transient or DC Analysis Simulation in the normal way using the 
additional .SETSOA and .OPTIONS commands in the Extra Simulation Data. If 
there are any violations, the results will be reported in the location you specified. 
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Full SOA Options Details 

 Option Name Default Description 
  value 

SOADERATING 1.0 Scales min and max values used in “.SETSOA” 
specification. This allows a de-rating policy to be 
globally applied to SOA limits. 

SOAMODE off Controls the Safe Operating Area (SOA) test mode. 
See “.SETSOA” below for details on how to define 
a SOA test. 

Can set to: 

Off  SOA testing is not enabled. In this mode 
.SETSOA controls will be read in and 
any errors reported, but no SOA testing 
will be performed during the run. 

Summary SOA testing enabled and results given in 
summary form with only the first 
violation for each expression given 
being output. 

Full  SOA testing enabled with full results 
given. Every violation will be reported 
in this mode. 

SOAOUTPUT list Can be:  

msg  Results displayed in command shell 
message window, or console if run in 
“non-GUI” mode 

list  Results output to list file 

msg|list  Results output to both list file and 
command shell message window 

none  Results not output to either list file or 
message window. 

Note that all results are always stored for retrieval 
using the script function GetSOAResults described 
below. So even if “none” is specified the SOA data 
is always available. 

Setting up SOA limits within a model 

It is possible to define SOA limits within the .MODEL statement. To do this, add 
one or more parameters in the following format: 

LIMIT(name)=(min, max, xwindow) 
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name  Name of quantity to test. See format for access variables 
useable when MODEL is specified for a .SETSOA control. 
This is described in section: “.SETSOA” in the section below. 
E.g. use ‘LIMIT(vcb)’ to specify the limits for the collector-
base voltage of a BJT. 

min, max  As described in “.SETSOA” below. 

xwindow  As described in “.SETSOA” below. 

Advanced SOA Limit Testing 

As well as the simple tests mentioned above, the simulator control .SETSOA 
allows much more sophisticated definitions for SOA limits. In particular, you 
can define limits for all devices belonging to a specified model. Suppose that you 
are using a BJT model that has a Vcb limit of 15V. While you could place a 
differential voltage watch device across each instance of this model, this would 
be time consuming and error prone. Instead, you can define a single .SETSOA 
control that refers to the model name of the device. The simulator will then 
automatically set up the limit test for every instance of that model. 

You would usually enter a .SETSOA control in the Pulsonix Extra Simulation 
Data option. See the Pulsonix Online Help for details.  

.SETSOA Definition 

.SETSOA [ LABEL=label ] [ MODEL=modelname | INST=instname ] 

[ ALLOWUNUSED ] [ ALLOWWILD ] 

expr1=( min1, max1[, xwindow1] ) 

[ expr2=( min2, max2[, xwindow2] ) ... ] 

Defines a Safe Operating Area (SOA) specification. If SOA testing is enabled 
the simulator will check simulated results against this specification and record 
any violations. 

The results of SOA testing are output to the list file by default and can optionally 
also be displayed in the command shell message window, or console window if 
run in non-GUI mode. They are also always available via a script function 
GetSOAResults(). See .OPTIONS setting “SOAOUTPUT” for more details. 

label  Optional label that will be included in every violation report. 
You can use the following symbolic values in this label: 
%INST% - substituted with the instance name that violated the 
specification. This is only meaningful if MODEL or INST are 
specified. (See below). 
%MODEL% - substituted with the model name that violated 
the specification. Only meaningful if MODEL is specified. 
(See below). 
%EXPR% - substituted with the expression that violated the 
specification. 
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instname  If specified the expression or expressions supplied in expr1 etc. 
are applied to the specified instance (e.g. Q23, M10, R56). In 
this case the expression may refer to node voltages and pin 
currents of the specified instance. See details under expr1, 
expr2... 

modelname  If specified the expression or expressions supplied in expr1 etc. 
are applied to every instance belonging to modelname. In this 
case the expression may refer to node voltages and pin currents 
for each instance processed. See details under expr1, expr2... 

expr1, expr2...  Expression to be evaluated and compared against minimum 
and maximum specs. This expression can access simulation 
results using access variables. The format and scope of these 
variables depends on whether MODEL, INST or neither is 
specified. 
If neither is specified, the expression can use the global access 
variables defined below: 

Syntax   Function   Example  

nodename  Voltage on node  VOUT – voltage on node VOUT 

n(nodename)  Voltage on node  n(VOUT) - voltage on node VOUT 

instname#param  Instance parameter  M2#vdsat – vdsat value for M2 

Q23#c – current in collector of Q23 

paramname  Parameter defined  
using .PARAM 

If there is a clash between a paramname and nodename, that is if the same name 
could refer to either a node or a parameter, then the parameter name takes 
precedence. To access the node in this case, use the n(nodename) syntax. 

Use the following values if MODEL or INST is specified. In each case 
(excepting the global access variable) the variable accesses a quantity for the 
instance being processed. With INST this will be the single instance specified by 
instname. With MODEL all instance belonging to the model specified by 
modelname will be processed.  

Syntax  Function  Example 

pinname Current in pin c - current in collector of transistor 

Ipinname Current in pin Ic - current in collector of transistor 

Vpinname Voltage on pin Vc - voltage on collector of transistor 

n(pinname) Voltage on pin n(c) - voltage on collector of 
transistor 

 

Vxy  
Where x = 

Voltage between x Vbc – voltage from base to collector 



 Pulsonix V4.0 Update   127 

pin name 1, 
y= pin name 
2. Both x and 
y must be 
single letters 

and y.  

pow Power in device 

 

 

param Readback parameter vdsat - ‘vdsat’ for MOSFET 

 

#global_name Global node voltage 
or pin current 

#VOUT – voltage on net called 
VOUT 

#q23#c – current in collector of q23 

paramname Parameter defined 
using .PARAM 

 

Note that currently the use of V() and I() is not accepted and will result in an 
error message being displayed. 

min, max  Minimum and maximum values respectively. A violation 
message will be produced if the value of the associated 
expression is less than min or greater than max. Use ‘*’ if the 
limit is to be ignored. E.g. (*, 15) will test a maximum value of 
15 but the minimum value will not be tested. min and max 
values may be scaled using the SCADERATING .OPTIONS 
setting (see below for details). Currently, only constant values 
are accepted for min and max. Expressions are not permitted. 

xwindow  Optional value specifies a minimum window that must be 
surpassed before limit violations are registered. For example if 
10u is specified for xwindow for a transient analysis, then the 
limit must be exceeded continuously for at least 10uS before 
the violation is recorded. 

ALLOWUNUSED If INST or MODEL are specified, an error will result if no 
instances to be processed are found. If INST is specified the 
error will occur if instname doesn’t exist. If MODEL is 
specified, the error will occur if there are no instances using 
modelname even if modelname itself is valid. 

This error will be inhibited if ALLOWUNUSED is specified 

ALLOWWILD  If specified, wildcards can be used for modelname and 
instname. In this case Pulsonix Spice will search for all devices 
that match the wildcard specification. Use ‘*’ to match any 
sequence of characters and ‘?’ to match a single character. 
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New SOA Testing Script 

GetSoaResults 

No arguments 

Return type: string 

Returns the SOA results for the most recent simulation.  

Return Value 

Returns an array of strings, each one describing a single SOA failure. Each string 
is a semi-colon delimited list with fields defined below. 

Field  Description 

0  SOA Label 

1   Start of failure 

2  End of failure 

3 under’ or ‘over’. Defines whether the test fell below a 
minimum limit or exceeded a maximum limit. 

4  Value of limit that was violated 

 

 



 Appendix A - Supplemantary File Changes   129 

Appendix A.  Supplementary File Changes 

This section details new default files and changes made to existing files. 

Format Files 
New format file examples are supplied on our web site and on the installation 
CD. These show examples of Report Maker features to guide you on creating 
your own. These are not installed with the product but can be accessed from the 
CD in the \Formats\Examples folder  Installed format files are also available on 
the CD to enable you to restore default ones if they become overwritten, these 
are in \Formats\Installed 

Standard Reports 
New reports have been added for: 

 Differential Pairs Report A new report to support the new high 
speed cost option 

 Pin Network Report A new report to support the pin network 
feature 

Changes have been made to: 

 Shortcut Keys Report Modified 

 Technology Report Modified 

 Critical Nets Report Modified 

Updated Libraries 

Existing Spice Libraries 

The spicemodels.lib and spiceexamples.lib libraries have been removed and 
rationalised with the main spice.lib library. Only one Spice library is now 
supplied. 

New Spice Models 

New models have been added to the Pulsonix Spice product libraries. 

 390 new MOSFETs, Diodes and IGBTs have been added to the IR 
library 

 85 new Opamps have been added to the LTC library 
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 140 new Transistors and MOSFETs have been added to the old Zetex 
library to make new Zmodel libraries.. 

New Spice libraries have been added for the following: 

 New Infineon library containing 450+ Discrete MOSFET models 

 Magnetic Core libraries containing 50+ models 

New Components/Symbols have been added to support the new models supplied. 

Standard Libraries 

Some of the MasterLibrary files have been updated to fix problems with 
existing library items. 

Design Examples 

New PCB design files have been added to show examples of the new embedded 
component technology. These are basic examples to show the principle of layer 
construction, layer class and access to this technology with the Technology file. 

 EmbeddedComponentsExample1.pcb  

 EmbeddedComponentsExample2.pcb  

 

New Spice examples are supplied in the \Examples\Spice folders. 
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